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Introduction

In recent years, the world of software development has changed a lot and for many reasons. Among others,
the large diffusion of mobile devices with different operating systems and of cloud platforms and services
has had a huge impact on the way developers write code and what they write code for. If you think about
how software development was just a few years ago, you will recognize some even bigger changes.

In fact, in the past, if you wanted (or needed) to build applications for different operating systems,
platforms, or devices, you had to use proprietary development tools and native frameworks on each specific
platform. For example, Microsoft Visual Studio has always been the development environment of choice
if you wanted to build Windows and web applications based on the .NET Framework with C#, F#, Visual
Basic, and C++. If you are like me and you have a lot of experience with .NET on Windows, you know how
powerful the .NET technology is. However, the limitation is that it runs only on Windows, which means
it requires you to publish your .NET web apps and services only to Windows Server systems, while many
companies actually want Linux as the host. Additionally, developers working on the Apple stack do not have
a framework available that allows for building web apps and services at all. As another example, building
mobile apps for Android, i0S, and Windows 10 requires knowledge of native frameworks, development
tools, and languages, such as Java and Google Android Studio for Android, Apple Xcode and Swift or
Objective-C for iOS, and Microsoft Visual Studio and C# (or Visual Basic) for Windows 10. As an implication,
the effort your company might need to make to publish an app on all the major stores can be huge and might
involve hiring several specialized developers to reduce the development time, which will mean higher costs.
Or this might mean waiting for the current developers to acquire the skills and experience they need to build
apps for different systems, which might save some money but requires much more time. And you know that
time is money. The list of examples might be longer and involve other technologies, such as cloud platforms
and containers, but these two are enough to give you an idea of what software development was at a certain
point in time. Concurrently, the demand for applications and services to be available on multiple platforms
has increased in the market. In summary, many companies have been in a situation in which they needed to
be on multiple platforms but with either limited resources or a very big effort.

Microsoft was aware of all the aforementioned problems, and in the last years the company has
significantly changed its vision and strategy, opening up to other platforms, embracing open source, and
focusing even more on cloud services. In fact, Microsoft has been making huge investments in bringing
technologies, platforms, developer tools, frameworks, and services to other operating systems such as Linux
and macOS and to typically non-Microsoft audiences by focusing on services much more than in the past.
In this strategy, cross-platform development is of primary importance and relies on two major technologies
(apart from cloud services and platforms).

e .NET Core, a modular, open source, cross-platform subset of the .NET Framework
that enables developers to write applications and services that run on Windows,
Linux, and Mac in C# and F#

e Xamarin, a technology that allows developers to write mobile applications that run
on Android, i0S, and Windows with C# and F#
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In this vision, there is one important pillar: using .NET languages such as C# and F# to write code for
any platform. The most important thing is that developers can reuse their .NET skills on Linux and macOS,
not just Windows. But to make this possible, developers need professional tools they can use to create the
next generation of application. Those working on Windows have Visual Studio 2017, the most powerful
version ever of the premiere development environment from Microsoft, which now supports a variety of
non-Microsoft technologies. For other systems, Microsoft released Visual Studio Code (http://code.
visualstudio.com), an open source, cross-platform tool that provides an enhanced coding experience.
However, Visual Studio Code has no built-in designer tools, has no support for Xamarin (at least currently),
and does not provide specialized tools that developers might need, for example, integrated publishing tools
or profiling instruments. After all, its focus is on providing an evolved editing experience. With its history
and tradition of delivering the best developer tools in the world and because you need a Mac to build, sign,
and distribute apps for iOS and macOS, Microsoft finally released Visual Studio 2017 for Mac (in May 2017),
an integrated development environment that can be used on macOS to build apps that run on any platform
and any device in C# and F# and that perfectly fits into this mobile-first, cloud-first vision. Visual Studio
2017 for Mac is neither a simple porting of Visual Studio on Windows nor is it an evolution of Visual Studio
Code. Instead, it is a professional development environment specifically built for the Mac, with native user
interface and tools tailored for macOS and for cross-platform development.

This book provides a comprehensive guide to Visual Studio 2017 for Mac, paying particular attention
to the integrated development environment, the workspace, and all the integrated tools you can leverage to
build high-quality, professional applications for mobile devices and the Web, using C# as the programming
language of choice. A basic knowledge of C# is strongly recommended to get the most out of the book
because it is not possible to concurrently teach the language and the Visual Studio for Mac environment in
one book. Therefore, I will assume you are familiar with the syntax and with the most common constructs.
You will also find an introduction to the Xamarin and .NET Core technologies so that you will learn the
necessary foundations to get started. Then you will be able to separately deep-dive into both technologies.
Actually, with Visual Studio for Mac, you can also develop games based on Unity (http://unity3d.com).
Game development with Unity will not be covered in this book, but it is worth mentioning that Visual Studio
for Mac already includes the tools for Unity out of the box, and you only have to install the Unity engine
separately.

Visual Studio 2017 for Mac is available in three different editions: Community, Professional, and
Enterprise. If you do not have an MSDN subscription and you are an individual developer, you can install
the Community edition for free from http://bit.ly/2tsuJvR. This edition can also be used under strict
licensing terms in both enterprise and nonenterprise organizations. Microsoft has a specific page that
describes the license for Visual Studio 2017 for Mac Community, available at waw.visualstudio.com/
license-terms/mlt553321.

Unless expressly specified, all the topics described in this book are available in all three editions.
Regarding system requirements, you will need a Mac with at least 4GB RAM, an 1.8GHz processor, and 1GB
of disk space. El Capitan 10.11 is the minimum version of macOS that supports Visual Studio for Mac. Of
course, the recommended configuration is with macOS Sierra 10.12 and with 8GB RAM. Just to give you an
idea, the machine I used to write this book is a Mac Mini 2014 with 8GB RAM.

After this short introduction, it is time to get started. But before you can put your hands on Visual Studio
for Mac, you need to set up and configure your Mac machine for development. That is what Chapter 1 is
going to explain.
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CHAPTER 1

Configuring the Mac
Development Machine

Visual Studio 2017 for Mac is a full-stack and mobile-first, cloud-first integrated development environment
(IDE) that allows you to build a variety of mobile and web applications using the most powerful technologies
from Microsoft, such as Xamarin for iOS and Android development and .NET Core for web development,
using C# and F# as the programming languages.

To fully leverage all the powerful features that Visual Studio 2017 for Mac offers, you first need to enable
some Apple services, and you need to install and configure Apple’s software development kits (SDKs) on the
development machine. In this chapter, you will learn how to configure your Mac development machine from
start to end. If you already have experience in building applications with the Apple developer tools on a Mac,
the first part of this chapter is just a recap. If you instead come from the Microsoft Windows world, the entire
chapter provides guidance to properly set up your Mac for the first time, explaining a number of concepts
that you might not be familiar with. By completing this chapter, you will be ready to start building mobile
and web apps with Visual Studio for Mac. Going forward, I will refer to Visual Studio 2017 for Mac also as
Visual Studio for Mac, Visual Studio, or VS for Mac interchangeably.

Getting an Apple ID

An Apple ID is a valid e-mail address that is linked to a number of Apple’s services and is required to set up a
developer account. If you own an iPhone or an iPad, you probably already have one because it is required to
download apps from the Apple Store, to access iTunes, and to set up your profile.

An Apple ID can be any valid e-mail address with any e-mail provider, so it is not necessary to create
anew alias for development. Instead, you can easily associate an existing e-mail address as an Apple ID.
Whether you create a new e-mail address or use an existing e-mail address, you can create your Apple ID at
http://appleid.apple.com/account.

Note When you buy a Mac computer and you turn it on for the first time, during the first configuration
macOS will ask you to enter your Apple ID. Though this is not mandatory, it is strongly recommended that you
supply your Apple ID at this point so that the operating system can set up your user profile. For this reason, it is
important that you get your Apple ID before you do anything else on your Mac.
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The Apple ID’s management page will ask you to enter your basic personal information, including your
e-mail address, and ask you to specify your security questions and the list of news you want to receive in
your inbox (optional). As you will see, this is a simple step.

Upgrading mac0S

The Apple SDKs and developer tools typically require the latest version of the operating system. At this
writing, the most recent version of macOS is 10.12.3 (also known as Sierra). Having that said, open the App
Store, select Updates, and make sure you install any updates available for macOS before going on.

Creating a Developer Account

With macOS, you can build applications using Xcode, the proprietary development environment from
Apple, or with third-party development tools such as Microsoft Visual Studio.

When compiling an application for iOS or macOS, third-party development tools will invoke Xcode and
the Apple SDKs behind the scenes to produce the binaries. Regardless of the tool you use, Xcode needs to
know and recognize who is going to build applications on the Mac. For this reason, every developer needs a
so-called developer account. A developer account is required to set up the proper development certificates
on the Mac and to test and debug an application on a physical device. Actually, a developer account is also
required to publish apps to the Apple Store. Apple provides the following options to get a developer account:

e  Free developer account: This is the most basic account and can be easily enabled with
your Apple ID.

e Apple Developer Program: This is a paid account and provides everything developers
need to build, test, debug, and publish apps to the App Store. This account includes
cloud-based analytics and allows for distributing private builds to testers.

e Apple Developer Enterprise Program: This is a paid account and provides specific
options for signing and distributing in-house apps within the organization.

e  MFiprogram: This is a special program that allows developers to get all the
components, tools, and documentation required to build electronic accessories that
connect to the iPhone, the iPad, and the iPod.

In this book, I will use the free developer account for your convenience. However, the free account has
the following limitations that you should keep in mind once you get more experienced in building apps for
iOS with Visual Studio and Xamarin:

e  You can deploy apps to only one physical device. This must be your own device.
e You cannot publish apps to the App Store.

e  You cannot distribute an app to testers with the Test Flight service, and you cannot
compile your code using the ad hoc or in-house configurations.

e You cannot leverage tools and services such as iCloud, push notifications, in-app
purchases, the Game Center, and the wallet.

e  Your Apple ID must not be already associated to other Apple Developer programs.

You can find more information about the aforementioned account options and pricing at
http://developer.apple.com/programs. In the next sections, I will explain how to set up the free
developer account in Xcode.
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Installing and Configuring Xcode

The Apple SDKs and development tools are the foundation for building apps on a Mac machine. Actually,
you do not need Xcode if you only want to build .NET Core applications with Visual Studio for Mac, but
because this book also explains how to create i0OS apps with Xamarin, Xcode is a requirement. This section
explains how to install and configure Xcode before moving on to installing Visual Studio for Mac.

Installing Xcode

Xcode is the integrated development environment from Apple. You use Xcode to build native apps for
macOS, i0S, and tvOS.

Of course, this is not the topic of this book, but Visual Studio for Mac invokes Xcode to compile your
Xamarin projects for iOS and macOS, so you need to install it before you do anything else. Open the App
Store and search for Xcode. If you click the Xcode icon, you will see all the information about the latest
available release. Figure 1-1 shows how Xcode appears in the App Store.

2.0.8 * E @ 9 ©

Featured  Top Charts  Categories  Purchased Upcates

Xcode

R L e L T e 1 ]

App License Agreoment

! i i Privacy Palicy
‘What's New in Version 9.0 vacy Palic
Xcode 9 includes Swift 4 and SDKs for i0S 11, watchO$ 4, w05 11, and macOS High Sierra 10.13

Information

5 10,12 6 or lat

Figure 1-1. Installing Xcode from the App Store
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On your machine, you will see Install instead of Open. The current version of Xcode is 9.0 and
requires at least version 10.12.6 of macOS. The download size of Xcode is 5.39GB, so it will take some time to
download and install. The App Store takes care of installing Xcode the proper way, so you just need to wait.
The installation also includes all the necessary Apple SDKs and the iOS simulator, which will be useful when
testing and debugging apps for the iPhone and the iPad.

Configuring the Developer Profile

After the installation has completed, the next step is configuring the developer profile inside Xcode. This
involves creating a blank project and configuring the developer account so that Xcode can generate signing
identities and team provisioning profiles.

Note Signing identities and team provisioning profiles are required by Apple to sign and distribute your
applications for i0S devices. A team provisioning profile contains an app identifier, one or more certificates
that identify the developer (or developers), and a list of registered devices. A device such as an iPad or
iPhone is registered when you connect it to the Mac; this is required by Xcode to generate the provisioning
profile when building apps for i0S. If you are building applications for mac0S, Xcode registers the current
Mac machine.

To accomplish this, start Xcode and select “Create new Xcode project.” You can select any of the
available project templates, but for the sake of simplicity, select Single View Application (see Figure 1-2) and
then click Next.
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Choose a template for your new project:

m watchOS  tvOS macOS Cross-platform (=)

Application

i ¥ - 2

Single View Game Master-Detail Page-Based Tabbed
Application Application Application Application
38 O
oo
Sticker Pack iMessage
Application Application

Framework & Library

& & &

Cocoa Touch Cocoa Touch Metal Library
Framework Static Library
Cancel Next

Figure 1-2. Selecting a project template

The next screen is of crucial importance. In fact, here you must specify some settings that will be used
later in Visual Studio for Mac. Because you will not actually need to write code, it makes no difference at all
what programming language (Swift or Objective C) or supported devices you specify here. The fields you
must fill in are the following:

e  Product Name, which defines the application name. The product name you supply
here will also be used in Visual Studio for Mac because of the association between
the tools and your developer profile.

e  Team, which allows you to associate one or more developer accounts to the application.
Click Add Account, enter your Apple ID, and then click “Sign in.” From the drop-down
box, you will be able to select your Apple ID that will be recognized as Personal Team.

e  Organization Name, which contains your name or your organization’s name.

¢  Organization Identifier, which represents a unique identifier for your organization.
By convention, the organization identifier includes the com. prefix.

e  Bundle Identifier, which is actually a read-only, autogenerated field, but it is of particular
importance. The bundle identifier uniquely identifies an application against the App
Store and the Apple services. Xcode concatenates the organization identifier with the
product name to generate the bundle identifier. Take note of the bundle identifier, as it
will be used in Visual Studio for Mac when building apps for iOS with Xamarin.
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Figure 1-3 provides an example that you can use as a reference.

Choose options for your new project:

Product Name: MyMobileApp

Team: Alessandro Del Sole (Personal Team)

Organization Name: Alessandro Del Sole

Organization Identifier: | com.alessandrodelsole] I

Bundle Identifier: com.alessandrodelsole.MyMobileApp

Language: Swift
Devices: Universal B
Use Core Data

Include Unit Tests
Include Ul Tests

Cancel Previous Next

Figure 1-3. Configuring the project properties

When you click Next, Xcode will ask you to specify a target folder for the new project. Select any
location, for example, the Desktop. After a few seconds, Xcode completes generating the certificates and
provisioning profiles for the current developer account, and it shows the project properties. Figure 1-4 shows
the Identity and Signing tabs, where you can see the application information and the provisioning profile
information, respectively.
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LaunchScreen.storyboard
Info.plist
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» [ Products

Bundle identifier  com.alessandredeisole MyMagileAop

Version 1.0

¥ Signing

Automatically manage signing

Team = Alessandro Del Sole (Persoral Team) B
Provisioning Profile Xcode Managed Profile ()

Signing Certificate iPhone Developer: delsole.a'e@gmail.com (VOIB2.

Figure 1-4. Identity and signing information for the current project

Now that the developer account has been configured and the provisioning profile has been generated,
itis time to enable the developer mode for the current Mac machine. To accomplish this, select one of the
available configurations for the iOS simulator (if you use Figure 1-4 as a reference, you can click where
you see iPhone 7 Plus) and then start the sample app by pressing Command+R. Xcode will show a pop-up
requesting your permission to enable the developer mode. Click Enable and wait for the application to be
started in the simulator. You do not really need to work with the app at this point, so you can just break the
application and quit the simulator.

Installing and Configuring Visual Studio for Mac

The final step in configuring your Mac is installing Microsoft Visual Studio for Mac. You can download the
tool from http://visualstudio.com/vs/visual-studio-mac. When the download is completed, you will
find the proper .dmg installer in the Downloads folder, so just click it to start the installation.

When the installer starts, you will need to click the Install Visual Studio for Mac button. You will then
be prompted with the license agreement, which you must accept to proceed. After accepting the license, the
installer will show the list of available components, as shown in Figure 1-5.
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Figure 1-5. Selecting components to be installed

Asyou can see, you can only select both Xamarin and .NET Core components. For the sake of
consistency with this book, make sure that all the components are selected and click Continue. Components’
names are really self-explanatory: Android is required to build Android apps; iOS and macOS are required
to build apps for iOS and macOS, respectively; and Workbooks & Inspector provides instrumentation for
Xamarin to analyze an application’s behavior. On the next screen, you will be invited to read and accept
individual license agreements for the various SDKs that will be installed on your machine. Once you have
accepted the license agreements, the installer will start downloading the required components, as shown in
Figure 1-6 where you can see the operation in progress.
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® 0 . Visual Studio - Installation

Downloading and installing...

Get started with Visual Studio

» Developer Center

Download components - 4.02 GB left nstallation
L ——1

Downloading Java SDK... 1.55 MB/s 1%
macOS may ask for your administrator password several times during installation Cancel

Figure 1-6. The installation progress

The installation process can take some time, because the download size can be up to 4.5GB depending
on the selected components. At the end, you will find the Visual Studio icon in the Applications folder that
you can easily open with the Finder tool. Double-click the icon to launch Visual Studio. When first started,
the IDE will look similar to Figure 1-7 (your news items will vary).
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# Visual Studio Community File Edit View Search Project Build Run Version Control Tools Window Help

[ NoN | > [ Default » Default Visual Studio Community 2017 for Mac Q-
oq) Visual Studio for Mac wmmms Sign .
Get Started Recent

Xamarin University Guest Lecture Recordings Now
= Discover what's new in Visual Your recent solutions will appear here. Free for Everyone!
Studio for Mac

Xamarin University has tons of great, expert-led live and on-
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-» Get up to speed with .NET Core Lokl demand content to help you j t your mobile
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So Many Mare Xamarin Dev Days!
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-» Find more news at The Visual Studio Blog

Figure 1-7. Visual Studio for Mac running for the first time

By default, when you install Visual Studio, you get the Community license. To unlock all the
available features and services or in order to enable a different license if you downloaded Visual Studio
from an MSDN subscription, it is strongly recommended that you log into Visual Studio for Mac with a
Microsoft account, which is normally an e-mail address based on an Outlook, Hotmail, or Live provider.
To accomplish this, simply click Sign In. A dialog will ask you to enter your credentials and will offer a
shortcut to a web page where you can create a Microsoft account if you do not already have one. Once
you have successfully signed in, you will see your username appearing instead of the Sign In shortcut.
In the sign-in dialog, you will also be able to add multiple Microsoft accounts. This can be useful if
you have different accounts for work and home or for development and testing. At this point, you have
completed all the necessary steps to get your Mac computer ready for development with Visual Studio for
Mac. Starting in the next chapter, you will learn how to use this powerful environment to build the next
generation of applications based on the Microsoft stack.
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Summary

To build applications with Visual Studio for Mac, you first need to configure the Mac for development. You

need an Apple ID that is associated to the Apple services and that can be used as a developer account.
You can opt for a free developer account, which is perfect for development and debugging, or for

a paid subscription. Whatever developer account you get, you need to install and configure Xcode and

the Apple SDKs. Xcode is Apple’s proprietary development environment that ships with the Apple SDKs

that Visual Studio for Mac invokes behind the scenes to compile Xamarin projects for iOS. The last step

in configuring the development machine is, of course, installing Visual Studio for Mac, which you can

install through a simple step-by-step installer. In the next chapter, you will start working with Visual

Studio for Mac, and you will learn everything you need to know to be productive with the integrated

development environment.
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CHAPTER 2

Getting Started with the IDE
and with Projects

As a developer, you will spend most of your time working with Visual Studio for Mac. This provides an
integrated development environment (IDE) that includes not only a rich code editor but also a large number
of integrated tools and features that make developers extremely productive.

Because Visual Studio for Mac is the tool you are going to use for your daily work, you need to know in
detail most of the features and tools it offers, from the code editor to productivity features to how it handles
file management. In this chapter, you will learn everything you need to know to get the most out of the IDE
and out of the code editor, and you will get familiar with all the features that you will typically use in your
developer life.

This is probably the most important chapter in the book, so I recommend you to read it carefully to get
familiar both with the IDE and with the concepts that will be used throughout the rest of the book, especially
in chapters where I explain how to build Xamarin and .NET applications. As a final note, keep in mind that
there are keyboard shortcuts for every tool I describe in this chapter. I will not use keyboard shortcuts very
often because I prefer you to learn where to find commands within menus, and there you will be able to see
keyboard shortcuts.

Note Visual Studio for Mac also allows working with the F# programming language against some specific
project types. However, F# will not be used in this book because it is tailored to functional programming. C# is
more popular, it is a general-purpose language, and it is fully supported by all of the available Xamarin and
.NET Core projects you can create with VS for Mac.

Taking a Step Back in History: Xamarin Studio

When Xamarin was a stand-alone company and started to offer the Xamarin development platform, it also
provided its own integrated development environment, called Xamarin Studio.

This IDE, which is still popular in the developer community, has some important points of strength: it
runs on Windows and macOS; it has adopted the Microsoft Visual Studio format for solutions and projects,
which also allows a Xamarin project to be opened in Visual Studio 2015 and 2017; and it allows working in
the same way regardless of the operating system. Microsoft immediately realized the potential of Xamarin
Studio and of how it could fit into the mobile-first, cloud-first strategy. For this reason, when Microsoft
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acquired Xamarin, Microsoft decided to evolve Xamarin Studio and introduce two important additions:
empowering the IDE with the .NET Compiler Platform (also known as Project Roslyn) for rich code editing
and live code analysis experience, and adding support for NET Core and cross-platform web development.
Asyou can imagine, Visual Studio for Mac is the result of the evolution of Xamarin Studio, and this book
explains how to get the most out of it.

Looking at the Welcome Page

When Visual Studio starts, the first thing you see is the welcome page. This contains a number of shortcuts
and links that simplify common tasks. Figure 2-1 shows how the welcome page looks.

‘ Visual Studio File Edit View Search Project Build Run VersionControl Tools Window Help

] Default » Default Visual Studio Enterprise 2017 for Mac
oq Visual Studio for Mac @
Get Started Recent

Xamarin University Guest Lecture Recordings Now
-» Discover what's new in Visual E droid1 Free for Everyone!
Studio for Mac ~[P
Xamarin University has tons of great, expert-led live and on-

= Gstup to speed with .NET Core demand content to help you j t your mobile d

- Learn about Mobile m Open... skills, and today we're making our Guest Lecture recordings
Development with Xamarin

free and ible 10 all Our monthly
Guest Lecture series allows Xamarin University students to join
live sessions with industry experts to learn about the latest...

S0 Many More Xamarin Dev Days!
Making Your Xamarin.Forms Apps Accessible
Developing Enterprise Apps using Xamarin Forms

=% Find more news at The Visual Studio Blog

Figure 2-1. The welcome page in Visual Studio for Mac

You can visit the welcome page at any time by selecting Window » Welcome Page. In the next
subsections, you learn more about the various areas and shortcuts.
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The Get Started Area

On the left side of the welcome page, you find the Get Started area. Here you find links to official online
resources that you can read to get further information about Visual Studio for Mac, .NET Core, and Xamarin.
Each link will open your web browser pointing to the appropriate learning resource.

The Recent Area

The Recent area displays the list of most recently used projects and is located on the right of the Get Started
area. If this is the first time you are starting Visual Studio, the Recent area will be empty. In Figure 2-1 you
can see a list of most the recently used projects as it appears on my machine.

Simply click a project name to open it. You can also filter the list by typing in the Filter text box. When
you hover your mouse over a project name, you will also see an icon with the x symbol, which allows you to
remove projects from the list. Notice that this action does not delete the project from disk; it just removes the
project from the list of most recently used ones.

The News Area

The News area is located at the right side of the welcome page and aggregates news and updates from the
Visual Studio team’s blog and other Microsoft online resources.

Simply click a hyperlink to open your web browser and read the full article or blog post online. This is a
convenient way to receive updates from Microsoft official sources and learn about new features and releases
of Visual Studio for Mac.

Reporting Problems and Providing Suggestions

At the top of the News area, you will also see two shortcuts called Report a Problem and Provide a
Suggestion. The first shortcut allows you to report any problems found in Visual Studio directly to Microsoft.
Visual Studio opens a page on the Developer Community web site (http://developercommunity.

visualstudio.com), where developers can report problems and monitor them for responses from the
product team. The second shortcut, Provide a Suggestion, will open the User Voice web site in your browser.
User Voice is the place where users can send their suggestions or feature requests about a particular
Microsoft product.

Understanding Runtimes and SDKs

Like any other development tool, Visual Studio for Mac relies on specific runtimes and software
development kits. These are necessary because both Visual Studio and the applications you build with
Visual Studio require them to work.

Visual Studio for Mac relies on the following four main platforms:

e The Mono framework: This is the popular cross-platform and open source porting
of the .NET Framework to operating systems such as macOS and Linux. Mono is
required by Visual Studio for Mac because it’s the engine that empowers mobile
applications that you create with Xamarin. Additionally, as you will discover later,
Mono allows you to build ASP.NET web applications and services for macOS exactly
as you would on Windows with .NET and Visual Studio 2017.
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e  TheJava SDK: This is required to build Android apps using Xamarin in Visual Studio
for Mac.

e The .NET Core platform: This is the new cross-platform, open source, and modular
runtime for the next generation of web applications that run on macOS, Windows,
and Linux.

e The Apple SDKs: Visual Studio for Mac needs these to compile Xamarin projects for
iOS and macOS.

Except for the Apple SDKs and for .NET Core that you installed when reading Chapter 1, the runtime
platforms are installed by the Visual Studio for Mac installer. You will get more detailed information about
Mono and .NET Core in Chapters 4 and 9, respectively, but this minimum knowledge is necessary for a
better understanding of the project types that you can create with VS for Mac.

Working with Projects

Note If you have experience creating projects with C# in Microsoft Visual Studio for Windows, many
concepts in this section will be familiar to you and will still be valid with Visual Studio for Mac.

Each time you want to develop an application, you create a project. A project is a collection of source
code files, resources, metadata, references and all the other files you need to build (or make in other
systems) an application or a library. In the Visual Studio family, a C# project is represented by a . csproj file,
whose structure is based on the Extensible Markup Language (XML) and which contains all the information
required by the IDE to fully represent a project.

An application or a library can be built from multiple projects linked together at compile time. For this
reason, Visual Studio has the concept of solution. A solution can be thought of as a container of projects,
and each can contain an infinite number of projects of different kinds, written in different programming
languages and with different targets. For example, a solution can contain a Xamarin project, a .NET Core
library, and an ASP.NET Web API service. Solutions are represented by . s1n files, whose structure is based
on XML. A solution file stores the information required by the IDE to manage all the projects a solution
contains. It is important to mention that solution and project files are standard across operating systems; this
means that Visual Studio for Mac can open a solution created with Visual Studio 2017 on Windows, and vice
versa. Of course, Visual Studio for Mac will only be able to open solutions that contain supported projects,
such as Xamarin and .NET Core projects. For a better understanding of why this is so important, think
of team collaboration: both Visual Studio 2017 and Visual Studio for Mac support Git as a source control
engine. As a consequence, people on a team can share their work on the source code, and they will be
able to collaborate on the same solution regardless of the operating system and IDE. This makes particular
sense with Xamarin, where it is common to have some people working on Mac computers and other people
working on Windows PCs. In the next subsections, you will learn the fundamentals about creating, running,
and managing projects in Visual Studio for Mac. Then, you will get more detailed information about
specialized project templates starting from Chapter 4.

Creating Projects

Creating projects in Visual Studio for Mac is a simple task. You click the New Project button on the welcome
page or select File » New Solution. Both actions open the New Project dialog, where you can see the full list
of available project templates. Figure 2-2 shows an excerpt of the full list, which you can see by scrolling the

list on the left side of the dialog.
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New Project

Choose a template for your new project

@ Recently used Recently used templates

Blank Native App (i0S, Android) cr
2 Multiplatform 4L Multiplatform - App
App Console Application cx 1
Library .NET Core - App |
Tests Android App o
Android = App .
i ios Blank Forms App o |
A Multiplatform - App |
o ASP.NET Core Web API .  BlankNative App (i0S, Android)
al E -
& B Creates a simple cross-platform app with
Tests one page.
= w0S The standard template has three
projects: i0S, Android, and third project |
App to house shared code in the form of
: either a Shared Project or a Portable
Hibtary Class Library.
# Android
App
Library
Tests
@® .NET Core
App
Tests

Figure 2-2. The New Project dialog presents the full list of available supported project types

In the next subsection, you will get a full explanation of the available project templates. Then in
Chapters 4 to 11 you will learn how to use most of them in detail. As a tip, remember that you can simply
click a project template to see a description on the right side of the dialog. For example, in Figure 2-2 you
can see a description of the Blank Native App (i0S, Android) project template. In this case, the description
explains how this project template generates a solution made of three projects: an iOS project, an Android
project, and a project to share reusable code. You will get a similar description when clicking the other
project templates.

Note The New Project dialog also presents a tab called “Recently used,” where you will see a list of the
most recently used project templates.

Understanding Available Project Types

Visual Studio for Mac allows for building applications for i0S, macOS, tvOS, Android and Android Wear,
and Windows.
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For i0S, macOS, tvOS, and Android, Visual Studio for Mac relies on Xamarin. More specifically,
you create apps for iOS and tvOS with the Xamarin.iOS libraries; apps for macOS with the Xamarin.Mac
libraries; apps for Android with the Xamarin.Android libraries; and cross-platform mobile apps for iOS
and Android with Xamarin.Forms sharing a single C# codebase. For cross-platform console and web
applications that run on macOS, Linux, and Windows, Visual Studio for Mac relies on .NET Core. At a higher
level, available project templates in Visual Studio for Mac can be categorized as shown in Table 2-1.

Table 2-1. Project Categories

Category Name Description

Multiplatform Contains Xamarin project templates that focus on code reuse to build cross-platform
apps, games, and libraries.

i0S Contains project templates based on Xamarin.iOS that allow building apps, games,
and libraries for the iPhone and the iPad.

tvOS Contains project templates based on Xamarin.TVOS that allow building apps,
games, and libraries for the Apple tvOS.

Android Contains project templates based on Xamarin.Android that allow building apps,
games, and libraries for Android devices, including wearable devices.

.NET Core Contains project templates that allow building cross-platform console and web
applications based on .NET Core.

Mac Contains project templates based on Xamarin.Mac that allow building applications
and games for macOS.

Other Contains miscellaneous project templates. The most relevant templates allow
building console and ASP.NET web apps and services that run on Mono.

I will now provide a complete explanation for each available template. Some of them will be used in the
book to demonstrate how to build mobile and web applications using Xamarin and .NET Core, respectively.

Multiplatform Templates

The Multiplatform category offers project templates that aim to maximize code reuse. In this category, you
find templates that allow sharing code by platform, such as Xamarin.Forms, or by project kind, such as
Shared Projects and Portable Class Libraries, all explained very shortly.

The Multiplatform category is divided into three subcategories: App, Libraries, and Tests. The
subcategory names are self-explanatory: App contains project templates that allow creating an app, Libraries
contains project templates that allow producing reusable libraries, and Tests contains project templates that
allow creating projects for Ul test automation. You will find the same subcategories in the iOS and Android
template categories. Table 2-2 summarizes the project templates in the App category.
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Table 2-2. Project Templates in the App Category

Platform Template Name

Description

Xamarin.Forms Forms App

Xamarin.Forms Blank Forms App

Native (i0OS, Android) Native App (iOS, Android)

Native (i0S, Android) Blank Native App (i0S, Android)

Games (i0S, Mac) SpriteKit Game

Games (i0S, Mac) SceneKit Game

Generates a solution that contains a
cross-platform Xamarin.Forms project
and an ASP.NET Web API back end
based on .NET Core and optimized for
publication to Microsoft Azure. The
Xamarin.Forms project contains sample
data and sample views to simulate a
to-do list app, including CRUD
operations and authentication.

Generates a solution that contains a
blank Xamarin.Forms project.

Generates a solution that contains

a Xamarin.iOS project, a Xamarin.
Android project, and a project to share
code between the two Xamarin projects.
This can be either a shared project or a
portable class library. Xamarin projects
include an ASP.NET Web API back

end based on .NET Core and sample
data and views to simulate a to-do list
app, including CRUD operations and
authentication. The back-end project is
optimized for distribution to Microsoft
Azure.

Generates a solution that contains blank
Xamarin.iOS and Xamarin.Android
projects, plus a project to share code
between the two, which can be either a
shared project or a portable class library.

Generates a solution that contains a
Xamarin.iOS project that allows creating
2D games based on the SpriteKit
framework from Apple.

Generates a solution that contains a
Xamarin.iOS project that allows creating
3D games based on the SceneKit
framework from Apple.
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The Library subcategory contains instead project templates that allow creating reusable libraries or
shared projects. Table 2-3 summarizes the available project templates in this subcategory.

Table 2-3. Project Templates in the Library Category

Platform Template Name Description

General Shared Project Generates a solution that contains a so-called Shared Project,
which allows sharing loose assortments of files between projects.

General Portable Class Library ~Generates a solution that contains a portable class library
(PCL), which can be consumed in Windows, Mac, Windows
Phone, Xamarin.iOS, and Xamarin.Android.

General Multiplatform Library ~Generates a solution that contains a PCL and a corresponding
NuGet package that can be compiled and distributed to the
NuGet gallery. If you are new to NuGet, the “Adding and
Managing Dependencies” section later in this chapter provides
a detailed explanation about it.

General .NET Standard Library Generates a solution that contains a C# library based on the
.NET Standard specifications. At this writing, Visual Studio for
Mac supports version 2.0 of .NET Standard.

Xamarin.Forms Class Library Generates a solution that contains a PCL that can be consumed
by Xamarin.Forms projects.

While all the project templates in Table 2-3 have the goal of maximizing code reuse and of sharing code
between projects, you might be confused by the three main types of Shared Project, Portable Class Library,
and .NET Standard Library, so I will provide some clarifications.

The Shared Project type can be thought of as a loose assortment of files, such as code files, images, and
XAML files. It does not produce a DLL library, and it can be just referenced from the projects in the solution
it belongs to. With cross-platform Xamarin projects, such as Xamarin.Forms, it allows using preprocessor
C# directives to invoke platform-specific code easily. For instance, using the Shared Project type, you could
write something like the following:

#if _ ANDROID _

// Write code invoking the Android APIs
#elseif I0S

// Write code invoking the iOS APIs
#else

//Write code invoking the Windows APIs
#endif

The Portable Class Library type is a special kind of library that will run on all the platforms and operating
systems you specify. Thus, it offers a common set of APIs that varies and is restricted based on your selection.
It does generate a compiled library that can be reused in other solutions and that can be distributed to
other developers. It does not allow using preprocessor C# directives to invoke platform-specific code, so in
platforms such as Xamarin.Forms, you have to use different patterns like the dependency service pattern.

The .NET Standard Library type provides a set of specifications for APIs that all the .NET development
platforms, such as .NET Framework, .NET Core, and Mono must implement. This allows for unifying .NET
platforms and avoids future fragmentation. By creating a .NET Standard Library project, you will be sure
your code will run on any .NET platform without the need of selecting any targets. Microsoft has recently
released version 2.0 of .NET Standard, which provides full unification for the .NET Framework, .NET Core,
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and Mono, and Visual Studio for Mac supports .NET Standard up to version 2.0. Microsoft has a well-done
blog post about .NET Standard and its goals and implementations that you can find at https://blogs.msdn.
microsoft.com/dotnet/2016/09/26/introducing-net-standard/.

The last subcategory is called Tests and contains only one template called UI Test App. This project
template generates a solution with a project that allows automating tests against the user interface both
locally and on Xamarin Test Cloud, the platform that provides a cloud-based environment with dozens of
devices that you can use to test the behavior of your apps.

iOS Templates and tvOS Templates

The iOS category is still divided into three subcategories called App, Library, and Test. In general, the iOS
category contains project templates that allow generating Xamarin.iOS projects that you can use to build
native iOS apps with C#.

Table 2-4 offers a detailed description of the i0S category.

Table 2-4. Project Templates in the App Category

Platform Template Name Description

General Single View App Generates a solution that contains a Xamarin.iOS project for a
single-page app with a Storyboard object that contains a View,
a View Controller, and a C# class.

General Master-Detail App Generates a solution that contains a Xamarin.iOS project
based on a Master-Detail view and that displays a list of
sample items. It is optimized for different screen form factors,
including a Navigation Controller for the iPhone and a Split
View on the iPad.

General Tabbed App Generates a solution that contains a Xamarin.iOS project
based on multiple pages contained in tabs. It includes a Tab
Bar Controller and a View Controller for each tab bar item.

General Page-Based App Generates a solution that contains a Xamarin.iOS project that
shows how to implement navigation between multiple pages
using a Page View Controller.

General WebView App Generates a solution that contains a Xamarin.iOS project that
allows displaying HTML contents inside a WebView object,
based on the Razor templating engine.

Games SpriteKit Game Generates a solution that contains a Xamarin.iOS project that
allows creating 2D games based on the SpriteKit framework
from Apple.

Games SceneKit Game Generates a solution that contains a Xamarin.iOS project that
allows creating 3D games based on the SceneKit framework
from Apple.

Games Metal Game Generates a solution that contains a Xamarin.iOS project that
allows creating games based on Metal, a GPU-accelerated 3D
framework from Apple.

Games OpenGL Game Generates a solution that contains a Xamarin.iOS project
that allows creating 2D and 3D games based on the OpenGL
framework APIs.
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The Library subcategory offers two project templates: Class Library, which allows for generating C#
class libraries that are tailored to Xamarin.iOS, and Bindings Library, a special project template that allows
for generating C# class libraries that can consume third-party Objective-C libraries for iOS. This particular
topic will not be covered in this book, but the Xamarin documentation has a specific page that you can find
athttps://developer.xamarin.com/guides/cross-platform/macios/binding/objective-c-libraries/.

The Tests subcategory offers two project templates called UI Test App and Unit Test App. The first
project template is similar to its corresponding template in the Multiplatform category, but it is tailored to
Xamarin.iOS and allows for automating tests against the user interface both locally and on Xamarin Test
Cloud. The second template creates a test project for Xamarin.iOS apps and libraries where you can write
unit tests based on the Touch.Unit framework.

Regarding tvOS, Visual Studio for Mac offers project templates that generate Xamarin.iOS projects
optimized for this kind of device. Supported project templates are Single View App, Tabbed App, SceneKit
Game, SpriteKit Game, and Metal Game. The description for each project template is the same as provided
in Table 2-4.

Android Templates

The Android category is divided into three subcategories called App, Library, and Test. In general, the
Android category contains project templates that allow generating Xamarin.Android projects that you can
use to build native Android apps with C#. Table 2-5 offers a detailed description of the Android category.

Table 2-5. Project Templates in the App Category

Platform Template Name Description

General Android App Generates a solution that contains a Xamarin.Android
project with a single sample screen (Activity) with a button
and a label.

General Wear App Generates a solution that contains a Xamarin.Android

project that targets the Android Wear operating system.

General Blank Android App Generates a solution that contains a Xamarin.Android
project with a single sample screen (Activity) and empty
user interface.

General WebView App Generates a solution that contains a Xamarin.Android
project that allows displaying HTML contents inside a
WebView object, based on the Razor templating engine.

Games OpenGL Game Generates a solution that contains a Xamarin.Android
project that allows creating 2D and 3D games based on the
OpenGL framework APIs.

Games OpenGL ES 2.0 Game Generates a solution that contains a Xamarin.Android

project that allows creating 2D and 3D games based on the
OpenGL ES 2.0 APIs. ES stands for Embedded Systems.

Games OpenGLES 3.0 Game Generates a solution that contains a Xamarin.Android
project that allows creating 2D and 3D games based on the
OpenGL ES 3.0 APIs. This is a most recent version with new
features and is backward compatible with 2.0.

24


https://developer.xamarin.com/guides/cross-platform/macios/binding/objective-c-libraries/

CHAPTER 2 © GETTING STARTED WITH THE IDE AND WITH PROJECTS

The Library subcategory offers two project templates: Class Library, which allows for generating C#
class libraries that are tailored to Xamarin.Android, and Bindings Library, a project template that allows for
generating C# class libraries that can consume third-party Java libraries for Android. This particular topic
will not be covered in this book, but the Xamarin documentation has a specific page that you can find at
https://developer.xamarin.com/guides/android/advanced_topics/binding-a-java-library/.

The Tests subcategory offers two project templates called UI Test App and Unit Test App. Similarly to
the i0S templates, the first project template is similar to its corresponding template in the Multiplatform
category, but it is tailored to Xamarin.Android and allows for automating tests against the user interface both
locally and on Xamarin Test Cloud. The second template creates a test project for Xamarin.Android apps
and libraries where you can write unit tests.

.NET Core Templates

The .NET Core project templates are extremely important in Visual Studio for Mac because they represent
one of the most evident points of evolution when comparing this IDE with Xamarin Studio. As you will
learn in more detail in Chapter 9, .NET Core is an open source, modular, cross-platform runtime that allows
building apps that run on Windows, Linux, and macOS with C#.

To build .NET Core apps, Visual Studio for Mac offers a number of specific project templates available
in the .NET Core category. This is divided into the App and Tests subcategories. Table 2-6 describes project

templates in the App subcategory.

Table 2-6. Project Templates in the App Category

Platform Template Name Description

General Console Application Generates a solution that contains a C# project for a
stand-alone, empty console application

ASP.NET ASP.NET Core Empty Generates a solution that contains an empty ASP.NET
Core web project

ASP.NET ASP.NET Core Web App Generates a solution that contains an ASP.NET Core
project that scaffolds a web application based on the
MVC framework

ASP.NET ASP.NET Core Web PI Generates a solution that contains an ASP.NET Core
project that scaffolds a RESTful service based on the
Web API framework

The Tests subcategory contains only one project template called xUnit Test Project that allows creating
unit tests based on the xUnit test framework.

Mac Templates

The Mac category is also interesting because it provides project templates that allow building applications,
games, and libraries for the macOS operating system using Xamarin.Mac with C#. This category is divided
into the App and Library subcategories, and Table 2-7 describes the App one in more detail.
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Table 2-7. Project Templates in the App Category

Platform Template Name Description

General Cocoa App Generates a solution that contains a Xamarin.Mac project with
a Storyboard for a stand-alone Mac application based on the
Cocoa framework from Apple

Games SpriteKit Game Generates a solution that contains a Xamarin.Mac project that
allows creating 2D games based on the SpriteKit framework
from Apple

Games SceneKit Game Generates a solution that contains a Xamarin.Mac project that
allows creating 3D games based on the SceneKit framework
from Apple

Games Metal Game Generates a solution that contains a Xamarin.Mac project that
allows creating games based on Metal, a GPU-accelerated 3D
framework from Apple

The Library subcategory contains the Class Library and Bindings Library project templates. Their
purpose is the same as described for their counterparts in Xamarin.iOS, with an important clarification
for the Class Library template: this one relies on the so-called Unified APIs, which means that code in this
library can be shared between Xamarin.Mac and Xamarin.iOS on both 32-bit and 64-bit systems.

Other Templates

Not limited to Xamarin and .NET Core projects, Visual Studio for Mac allows working with a number of
additional project types. Among the others, the most important thing to highlight at this point is that the IDE
supports several classic .NET projects such as Console, ASPNET MVC, and ASP.NET Web Forms projects.

This is possible because of the Mono runtime, which allows running these kinds of applications even on
a Mac. The miscellaneous supported project types are available in the Other category, which is divided into
the .NET, ASP.NET, and Miscellaneous subcategories. Except for where any differences are expressly stated,
here .NET means the .NET Framework, not .NET Core.

Note The project templates described in this subsection will not be used in this book, whose goal is to
demonstrate how to use VS for Mac with a mobile-first, cloud-first strategy. Still, it is important that you know
they exist and that you can use them to work on a variety of .NET projects even on a Mac. It is also worth
mentioning that most of these projects not only support C# and F# but also Visual Basic as a programming
language.

Table 2-8 describes the project templates in the .NET subcategory.
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Table 2-8. Project Templates in the .NET Category

Template Name

Description

Console Project

Empty Project

Gtk# 2.0 Project

Library

F# Tutorial

NUnit Library Project

NuGet Package

Generates a solution that contains an empty console project

Generates a solution that contains an empty C# project with only the
basic references

Generates a solution that contains a project based on Gtk#, a cross-
platform framework for creating user interfaces

Generates a solution that contains an empty C# class library
project for .NET

Generates a solution that contains an F# project with a single file that
contains a variety of code examples

Generates a solution that contains a library project for unit tests based
on the NUnit framework

Generates a solution that contains a project that allows for building a
NuGet package from files and libraries

As I said before, VS for Mac also supports some classic ASP.NET project types, such as MVC and Web
Forms. Supported projects are included in the ASP.NET subcategory, and they are described in Table 2-9.
Regarding ASP.NET on Mono, it is worth mentioning that Mono is not supported for running web
applications in production, whereas .NET Core is.

Table 2-9. Project Templates in the ASP.NET Category

Template Name

Description

Empty ASP.NET Project

ASP.NET MVC Project

ASP.NET Web Forms Project

Generates a solution that contains an empty ASP.NET web project with
its basic infrastructure

Generates a solution that scaffolds an ASPNET MVC web project using
Razor views

Generates a solution that scaffolds an ASP.NET project based on the
Web Forms technology

The projects described in Table 2-9 give Visual Studio for Mac great flexibility and allow you to work
with your existing codebases even on a Mac. The last subcategory is called Miscellaneous and provides the
project templates summarized in Table 2-10.

27



CHAPTER 2 © GETTING STARTED WITH THE IDE AND WITH PROJECTS

Table 2-10. Project Templates in the Miscellaneous Category

Template Name  Description

Blank Solution Generates an empty solution that you can populate with any of the project types
described so far.

Workspace Generates a new workspace, which might be thought of as a container of solutions.
Notice that workspaces are not supported in Visual Studio 2017 on Windows.

Empty Project Generates a solution that contains a completely empty C# project.

After the detailed description of each project type, you should have a clearer idea of what kind of
applications you can build with Visual Studio for Mac.

Opening Existing Solutions

You have different options to open existing solutions from disk. You can select a solution by clicking the
Open button on the welcome page, or you can select File » Open. Notice that Visual Studio for Mac is
not limited to open solution files; it also allows opening individual project (. csproj) files, and then it will
generate a root solution for the project.

Additionally, you can open solutions from the list of most recently used ones that is available on the
welcome page, or you can do this by selecting File » Recent Solutions and then select the solution you need
from the submenu that appears. This submenu also provides a command called Clear that deletes the list of
most recently used solutions.

Creating Your First C# Project

In this section, you will learn how to create your first C# project in Visual Studio for Mac. Though it might
seem an easy step, and actually it is, you will also learn a number of concepts and features you will reuse
with whatever project template you choose to work with. For the sake of simplicity, you will start with a C#
console application based on .NET Core.

In fact, the focus of this chapter is not explaining how the various development platforms work; rather,
the focus is on getting to know the most common and important features in the IDE that you need to
know when working with any kind of project. Thus, the Console project template is perfect because it’s the
simplest template possible. Having that said, click New Project on the welcome page or select File » New
Solution. When the New Project dialog appears, select the Console Application template in the .NET Core
category and then click Next. If multiple versions of the .NET Core runtime are installed on your machine,
VS for Mac will ask you to select one. Select either 1.1 or 2.0 and click Next. At this point, the New Project
dialog asks you to specify a project name and a solution name, which is common to all the supported project
templates. The Solution Name text box is automatically populated as you type the project name, but you can
certainly provide a different solution name (which is not uncommon). Because everything starts with a Hello
World example, type HelloWorld as the project name. Figure 2-3 shows how the New Project dialog appears
at this point.
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[ XoN ] New Project

Configure your new Console Application

PREVIEW
B jUsers/al drodelsole/Projects
I Helloworld
[ Helloworld.sin
s Helloworld
Project Name: | HelloWorld | [ HelloWorld.csproj

Solution Name: | Helloworld |

L i [!I ] fal irodelsole/Projects | Browse...
Create a project di y within the solution directory.
Version Control: Use git for version control.

Create a .gitignore file to ignore inessential files.

care provous . [EEREND

Figure 2-3. Creating a new project

The Location text box allows you to specify a folder for your new solution. By default, Visual Studio
for Mac creates a Projects folder under the Home directory of your Mac. You can click Browse to select a
different folder, or you can simply type a new folder name, and you can also change the default folder in
the IDE options, as you will learn in Chapter 13. I recommend you leave the check box called “Create a
project directory within the solution directory” selected. This option ensures that a root folder is created for
the solution and that a subfolder in the solution folder is created for the new project. This helps keep the
solution’s structure well organized, especially if you plan to add new or existing projects to the solution later.
The New Project dialog provides a visual representation of the solution’s folder structure on the right side,
under Preview. You will see how this preview changes depending on selecting or deselecting the directory
check box. You also have an option to enable Git version control for the solution, but this will be discussed in
more detail in Chapter 12, so let’s leave this out for now. Click Create when ready. After a few seconds, your
new project will be ready. If you have never made customizations to the IDE before, by default you will see
the Solution pad on the left side of the workspace and the code editor on the right side. You might also see
additional pads, such as Errors. If you do not see the code editor, expand the project view in the Solution pad
and double-click the Program.cs file. At this point, your workspace should look like Figure 2-4.

29


http://dx.doi.org/10.1007/978-1-4842-3033-6_13
http://dx.doi.org/10.1007/978-1-4842-3033-6_12

CHAPTER 2 © GETTING STARTED WITH THE IDE AND WITH PROJECTS

® VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help

[ RoN ] > O Debug » Default Visual Studio for Mac Preview Q- F
©  [& solution a < 2  Program.cs = T
(¢} =4
& ¥ [5 HelloWord No selection g
& ¥ HelioWorld 1 wusing System; g

¥ [51 Dependencies 2
v [ SOK 3 namespace HelloWorld B
—_— 0
» D Microsoft.NETCoreApp (1.1.1) 4 b
| OPogomes | 8 Sy Prigre i
[ 5 5
7 static void Main(string[] args)
8 {
9 Console.WriteLine("Hello World!"); g
19 &
11 } S
2L} 4
13 g
5
c
Z
=
]
&
@ Breakpoints SErrors
€ 0Errors 0Wwarnings ) 0Messages B8 Build Qutput Q I

) Line Description File Project Path Category

+ Tasks [ Package Console

=

Figure 2-4. The workspace after the project has been created

When you create a new project or open an existing solution, Visual Studio for Mac will automatically
attempt to refresh any references to external libraries, such as NuGet packages. This might take a few
seconds, and you will see the progress of the restore operation in the upper status bar (where you can
normally see the Visual Studio icon and product name). This is important to remember because you might
have projects that have dependencies, and you might see some error squiggles in the code editor until the
process of restoring libraries is completed. The Solution pad is an important tool, and you will work with it
all the time. It basically provides a hierarchical view of your solution, and it allows you to browse for files and
folders.

Note Generally speaking, a padis a pane that can be rearranged on the screen or hidden and that can
either contain some kind of specific information or allow for executing contextualized actions. Visual Studio for
Mac provides many pads that the section “Working with Pads” in this chapter will discuss intensively.

In the Solution pad, you can also right-click the solution name and then select Add » New Project or
Add » Existing Project to add new or existing projects, respectively, which is common. You can also add
individual files and folders (referred to as solution items) that will not be part of the build output but that you
might need for several purposes, such as documents or images you might want to include for your team.
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For each project in the solution, the Solution pad not only shows files but also dependencies
your project has on specific SDKs (such as .NET Core in the current example) or on external libraries.
Dependencies will also be covered in more detail in this chapter. Notice how the code editor provides syntax
colorization for any of the supported languages, as you might certainly expect. While developing, you will
need to test and debug an application many times, so you need to understand how to start an application for
debugging and the concepts related to this task.

Building and Running an Application

Compiling code and running the resulting application in Visual Studio for Mac is certainly easy, but it
requires you to be familiar with two concepts: assemblies and build configuration. This section explains
both concepts, and then you learn how to start an application with or without the debugging tools attached.

Understanding the Concept of Assemblies

In .NET terminology, a very important word is assembly. Put succinctly, an assembly is the final compiled
output that results from building a .NET or .NET Core project and can refer both to an executable and to a
.d11library. Assemblies are self-describing units made of metadata and Intermediate Language (IL) code.
Metadata describes the name, the version number, the icon, and the types and members defined in the
assembly. The Intermediate Language is what compilers actually produce. Then when you start a .NET
application, the IL in the assembly is compiled on the fly by the just-in-time compiler into machine language.
Discussing in more detail assemblies, how they are made, and how .NET manages assemblies is
out of the scope of this chapter. Some more details and concepts will be provided in Chapter 9, while
full documentation is available in the MSDN documentation at https://msdn.microsoft.com/en-us/
library/8wxf689z(v=vs.110).aspx. For the purposes of this book, when you encounter the word assembly,
remember it can refer to both an executable and a reusable .NET library.

Understanding Configurations

Build configurations, or simply configurations, influence the way your code is compiled into an assembly or
app package. A configuration determines whether the compilation output should include debug symbols
and which architecture your application should target, such as x86, x64, or both.

By default, Visual Studio for Mac offers two built-in configurations: Debug and Release. As its name
implies, the Debug configuration is used when you want to test and debug an application at development
time; it is optimized for debugging scenarios because it generates debug symbols that are included in the
compilation output and attaches an instance of the debugger to the application. On the contrary, the Release
configuration does not include debug symbols and does not attach an instance of the debugger to the
application, so you will use this one when you want to release your app or library. The easiest way to select
the build configuration is from the appropriate drop-down box in the toolbar, as shown in Figure 2-5.

@ Visual Studio File Edit View Search

O O 23 Debug befault
! Release |
© [ Solution o <

Figure 2-5. Selecting a build configuration
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You can also create custom configurations, as discussed in the “Configuring Build Options” section later
in this chapter. Now that you have knowledge of configurations, you can compile and run your first project.

Compiling and Building Projects

Before you can run, test, and debug an application, you need to build your solution. Building a solution
means generating an assembly or app package by compiling the source code from all the projects into
intermediate objects that are then linked to the appropriate libraries.

As for Visual Studio 2017 on Windows, in Visual Studio for Mac, solutions might be made of multiple
projects of different kinds. This means that the various projects in a solution must be built individually and
then linked to one another, and to the necessary libraries, into the final executable. Luckily enough, Visual
Studio for Mac leverages the popular MSBuild engine that handles the entire build process for you from start
to end, taking care of compiling projects in the appropriate order, invoking external tools when necessary,
and then generating the complete build output. In Visual Studio for Mac, you build a solution (or individual
projects) with commands from the Build menu or with same-named shortcuts available if you right-click
the solution or project name in the Solution pad. More specifically, you have the following commands that
target an entire solution:

e  Build All: This command builds a solution and generates the proper output, such as
an executable, a library, and an app package.

e Rebuild All: This command is similar to Build All, with an important difference: Build
All performs a full build only the first time; the next time, it only updates the build
output by compiling updated code. Rebuild All, instead, performs a full build of the
solution every time.

e  Clean All: This command cleans the build output and is useful when you want to
refresh the build process.

Note Saying that building a solution produces an executable, a library, or an app package must be
further clarified. In fact, there are situations in which building a solution generates more than one output. For
instance, in a single solution you might have different project types, such as a Xamarin project and an ASP.NET
Core back-end project. In such situations, Visual Studio does not produce a single app package or application;
instead, it generates multiple build outputs, an app package, and an ASP.NET Core web application. Situations
like this are extremely common, especially with solutions that contain many library projects and a project for an
executable or app package.

The Build menu also offers Build, Rebuild, and Clean commands against individual projects in
the solution. These can be useful when you make edits to a particular project and you want to see if it
is compiled correctly. When you build a solution or an individual project, the IDE’s status bar shows
the operation progress, and it offers a red Stop button that you can click to cancel the build operation.
Remember that the time for the build process varies depending on the number of projects in the solution
and on their complexity.

The build output, and thus one or more assemblies generated by the compiler, will be available by
default in the Bin\Debug or Bin\Release project subfolders, depending on the active build configuration.
Later in the section called “Configuring Build Options,” I will explain how to change these paths. Once you
have built your solution, you can run it for testing and debugging.
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Running Applications with and Without a Debugger

You can run your solutions with the Start button in the toolbar and with two commands from the Run menu:
Start Debugging and Start Without Debugging.

In the first case, you select the Debug configuration, and then you invoke the command. This will
launch the application from within the IDE, with an instance of the debugger attached, and will enable
the powerful debugging tools in Visual Studio that you will learn to leverage in the next chapter. In the
second case, you can select the Release configuration, and the application will start without an instance of
the debugger and detached from the IDE. You can certainly leave the Debug configuration selected when
running the application without debugging, but the generated debug symbols will be ignored. Once you
have selected the configuration, you can start the application; besides the two commands in the Run menu,
the easiest way to do this is by clicking the Start button, which you can see in Figure 2-5. When you start the
application, Visual Studio first performs a Build All operation if it detects some changes from the last build
or if you have never built the solution before. It does not perform a Build All operation if you already called
Build All or Rebuild All before starting the application. Figure 2-6 shows the sample console application
running in Terminal.
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Figure 2-6. Running an application

In this case, the application has been started with the Debug configuration enabled; thus, an instance
of the debugger is attached. All the steps you have seen so far apply to all the supported project types, and
the only difference will be the application host, which can be a Terminal window, a web server, a device
simulator, or a physical device depending on the project type.

Adding and Managing Dependencies

Any application needs core runtime platforms or libraries to work. These are known as dependencies.
For example, the .NET Core SDK is a dependency for any .NET Core application. The Mono runtime is a
dependency for any Xamarin project.
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Regarding core dependencies, Visual Studio for Mac takes care of adding the proper references based
on the type of project you create. More often than not, your applications will need to use third-party libraries,
or libraries you developed, that expose APIs and objects that the core libraries do not provide out of the
box. When this happens, you are introducing additional dependencies. In VS for Mac you have two main
ways to add and consume dependencies in your applications: adding references to libraries on disk and
downloading NuGet packages. This section walks through both scenarios.

Note Remember that references are per project, not per solution.

Adding References to Libraries

If you need to consume a library that is on disk, either third-party or developed by you, in the Solution pad
you can add a reference to the library. The way you add a reference to a project changes a bit depending on
the project type.

e Ina.NET Core project, you right-click the Dependencies node in the Solution pad

and then you select Edit References.

e InXamarin and .NET projects, you right-click the References node in the Solution
pad and then you select Edit References.

Regardless of the project type, Edit References opens the Edit References dialog, where you will be able
to select libraries with the help of four tabs: All, Packages, Projects, and .Net Assembly. Figure 2-7 shows an
example based on a Xamarin project.

[ NoN | Edit References

| r . e
i Met A | (Q Search (®F)

I, ”Ni Packages Projects ] et Assembly \ -~ Search (P oot | =
! Assembly Version Path _ ”
1 | D Xamarin.Forms.Core
" + [l Xamarin.Forms.Core.dl| 2.0.0.0 [Usersfalessandrodelsole/Projects/Xami/packages/Xal | ersfalessandrodelscle/Projects/Xamijpa
| B8 Xamarin.Forms.Platform.dll 1.0.0.0 (Users/al drodelsole/Projects/Xam1/packages/Xam | I:’ Xamarin.Forms.Platform )
| B8 Xamarin.Forms.Xaml.dll 2.0.0.0 JUsers/al drodelsole/Projects/Xam1fpackages/Xam | | ; .

|| ‘I Xamarin.Forms. Xaml

Browse...

Cancel OK

Figure 2-7. The Edit References dialog
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The Packages tab lists installed libraries that Visual Studio is able to detect as available for the current
project. The Projects tab allows adding a reference to other projects in the solution, which is common when
you have class library projects that expose custom objects or APIs. The .Net Assembly tab shows a list of .NET
assemblies that are currently referenced by the project. For instance, you could simply double-click a library
listed on the Packages tab to immediately add a reference. If the library you need is not listed but available
on disk, you can click Browse, locate the library, and select it to add a reference. At this point, you will be
able to consume the objects exposed by the library in your code. This approach for adding dependencies has
three important limitations.

e Itrequires you to have the library on your disk.

e Itdoes not automatically resolve any additional dependencies that the library you
are referencing might rely on, so this is something you must take care of manually.

e Itmakes it difficult to manage different versions of the library and its dependencies
once new versions are available. For instance, if a new version of a library is available
and it also relies on an updated version of a dependency, you must take care of
both manually. The same concept applies if you want to downgrade to a less recent
version.

NuGet solves all these problems, and it is discussed thoroughly in the next subsection.

Working with NuGet Packages

NuGet is an integrated package manager that has been very popular among developers using Microsoft
Visual Studio on Windows and Xamarin Studio since the beginning. Through a convenient, integrated user
interface, the NuGet Package Manager allows you to download and reference a huge number of popular
libraries, and it also automatically resolves any further dependencies that a library might need.

Not limited to this, NuGet makes it extremely easy to manage different versions of a library and of
its dependencies. Libraries are bundled into so-called NuGet packages, which are files with the . nupkg
extension and that contain the library, metadata that helps developers identify a library, and information
about dependencies that a library needs to be consumed properly. NuGet packages are hosted on (and can
be published to) an online repository available at NuGet.org. If you visit this web site, you will be able to
browse the gallery outside of Visual Studio and see what’s available.

I recommend you spend some time getting familiar with NuGet because it is becoming the de facto
standard for managing dependencies both in Visual Studio for Mac and in Visual Studio on Windows. As
a general rule, in the Solution pad you right-click the Dependencies node for .NET Core projects and the
References node for Xamarin and .NET projects and then you select Add Packages. This will open the Add
Packages dialog, which you can see in Figure 2-8.
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Figure 2-8. Adding NuGet packages

The Add Packages dialog shows the list of available packages from NuGet.org.

Note Because NuGet packages contain libraries, talking about references to NuGet packages and to
libraries has basically the same meaning.

You can also create custom repositories, as I will discuss in Chapter 13. As you can see in Figure 2-8, for
each package you can see the description, the author, the publication date, the number of downloads, and,
very important, the license agreement and the additional dependencies the package requires. By default,
only stable releases are displayed, but you can select the “Show pre-release packages” check box to show also
prerelease versions. In the Version drop-down box, you see the latest version available by default, but you can
pick a different one. You can select multiple packages, but for now simply select the Json.NET package, the most
popular library for .NET that makes it dramatically easy to serialize and deserialize to and from JSON markup.
You will not actually use the library in code in this chapter; it is just the package I'll be using for demonstration
purposes. At this point, Visual Studio will show a dialog that contains a list of all the libraries that will be
installed and a link to the license agreement for each. When ready, click Accept to accept the license agreement
for all the libraries. While Visual Studio downloads and installs the NuGet package with its dependencies, you
will see the operation progress in the status bar. When finished, you will be able to see the Json.NET library just
installed in the Solution pad, but the location changes based on the project type. For .NET Core 2.0 projects,
installed NuGet packages are located under the Dependencies node; for .NET Core 1.x projects, installed NuGet
packages are located under the NuGet node; for Xamarin projects, installed NuGet packages are located under
the Packages node. Packages can be also expanded to see the list of dependencies they rely on. Figure 2-9
shows an example based on the Json.NET library and a .NET Core 1.1 project.
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Figure 2-9. References added via NuGet and their dependencies

When a NuGet package and its dependencies are installed, Visual Studio for Mac automatically
adds a reference so that you can consume libraries in your code. If you want to install a different version
of an already installed package, you have two options. The first option is automatically updating NuGet
packages to the latest stable release available, which you do by right-clicking the solution name in
the Solution pad and then selecting Update NuGet Packages or by selecting Project » Update NuGet
Packages. The second option instead allows you to select a specific version of a NuGet package: simply
right-click the NuGet node and then select again Add Packages. Select the package you want to upgrade

(or downgrade), select the version number in the Version drop-down box, and finally click Add Package.

Figure 2-10 demonstrates this.
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Figure 2-10. Selecting a different NuGet package’s version number

Whenever Visual Studio for Mac performs any operations related to NuGet packages, it displays the
output in the Package Console pad, which you enable with View » Pads » Package Console. Figure 2-11
shows an example.
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Figure 2-11. The Package Console pad shows output from NuGet
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The Package Console pad is particularly useful when installing NuGet package fails because it provides
detailed messages. A common reason for failure is selecting a NuGet package that is not compatible with
the current project or a dependency of the selected NuGet package that is not compatible with the current
project.

The way NuGet packages are managed is a little bit different depending on the development platform
you are working on. For .NET Core, the list of required NuGet packages is stored inside the .csproj project
file. Additionally, when NuGet packages are downloaded, they are stored inside a local cache for easy reuse.

For other project types, such as Xamarin and the full .NET, NuGet packages are downloaded into a
project subfolder called Packages, and Visual Studio stores the list of required packages inside a file called
Packages.config. In both cases, Visual Studio for Mac always knows what NuGet packages a solution
needs. This is important because, if a library is missing, Visual Studio can easily restore it. For example,
if a solution is under source control, it's not uncommon that libraries are not sent to the server. So, when
you download a solution from the Git source control repository of your choice for the first time, VS for Mac
will check if all the NuGet packages are available locally. If not, it will perform a restore operation. Another
example of when restoring NuGet packages is required is when you share a solution with other people,
such as in the form of a . zip archive or on a web site. Because your solution might rely on a large number
of packages, you can exclude them from the archive to save a lot of space. This is typically the case with
Xamarin or full .NET projects, where you can completely delete the content of the Packages subfolder.
When other people open the solution on their machine, Visual Studio checks if the required libraries are
available; if not, it reads the content of Packages . config, and then it performs a restore operation. Usually,
restoring NuGet packages occurs automatically when you open a solution, but you can restore packages
manually by right-clicking the solution name in the Solution pad and then selecting Restore NuGet
Packages or by selecting Project » Restore NuGet Packages.

Note The official NuGet repository is hosted on a web site, so you should typically have an Internet
connection when working with NuGet packages. However, Visual Studio for Mac manages a local cache of all
the NuGet packages that are minimally required to create new projects. This is the case with Xamarin and full
.NET projects. Regarding .NET Core, a local cache is also available and is managed by the platform directly. Put
succinctly, you will always be able to create any of the supported projects even when offline. Then, if you need
to download or update NuGet packages, you will need an Internet connection. Luckily enough, you can even
create a local NuGet repository so that you will be able to reference the NuGet packages you use the most even
if an Internet connection is not available.

Configuring Project Options

Visual Studio for Mac provides you with deep control over a project. In fact, you can edit a number of project
properties and options so that you can provide additional information and also influence the build process.
This section describes options that are commonly available to all the supported project types in VS for Mac;
the project options that are specific to .NET Core and Xamarin solutions will be detailed in the appropriate
chapters.

You access the project options with Project » {ProjectName} Options or by right-clicking the project
name in the Solution pad and then selecting Options. The Project Options window appears at this point
(see Figure 2-12).
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Figure 2-12. The Project Options window

In the General node, you find Main Settings, which is the same for all the supported project types.
Here you can specify a different project name, a specific version number, an optional description, and the
root C# namespace, and you can change the root directory where the project files are stored. By default, the
project version is inherited from the solution version, but you can deselect the “Get version from parent
solution” check box and provide a new version. The other settings are generated based on the information
you supplied when you created the project, and unless you have specific requirements, I recommend you
leave them unchanged.

Note Some options can be configured at the solution level by right-clicking the solution name in the
Solution pad and then selecting Options. Common options you might set are those that projects inherit, such
as the version number, the author information, and the output folder for binaries. | recommend you work with
the project options rather than with solution options because every project has its own specific settings and
requirements.
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Configuring Build Options

In the Build node of the Project Options dialog, the General tab allows you to change the target framework.
For .NET Core projects, the target framework is by default the latest runtime version available. With Android
projects, the target framework is the version of the Android APIs used for the build process. With i0S
projects, the target framework represents the SDK that should be used depending on the target device (i0S
or WatchOS). Figure 2-13 provides an example based on a .NET Core application.

@] Project Options — HelloWorld
v G 1
Fhe General
# Main Settings
¥ Build
Target f k: | .NETCoreApp 1.1[1

# Custom Commands

O configurations Code Generation
@ Compiler Compile Target: Executable Q
&% Assembly Signing ik Chace. |
4 Output
e Win32 lcon: [ ‘ Browse...
v i Configurations
P Default Compiler Code Page: | L:J

¥ Source Code
EJ .NET Naming Policies
» [@ Code Formatting -
[® Standard Header C# Language Version:  Default L_}

* Version Control

Do not reference mscorlib.dil

Language Options

Allow 'unsafe’ code
®© Commit Message Style

* NuGet Package
# Build
[E Metadata

Figure 2-13. The General options

In the Code Generation group, you can change the compile target (Executable, Library, Executable
with GUI, Module), the startup C# class in the Main Class box, the icon file in the Win32 Icon box, and the
encoding code page for source files in the Compiler Code Page box. I recommend you not change the default
options, including the “Do not reference mscorlib.dll” check box value, because the defaults are already
optimized for your project. Changing these options makes sense in full .NET projects, not .NET Core.
Additionally, you can specify the C# version the compiler should use in the C# Language Version
box. The Default setting ensures the compiler uses the latest version of the language available. The “Allow
‘unsafe’ code” check box should be left unselected in a .NET Core project, as you will not typically invoke
native code.
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The Custom Commands Tab

The Custom Commands tab allows you to specify any actions that should be executed before, during, or
after a build or clean process. Actions are per configuration, so you can specify different actions for different
configurations. By default, the Configuration drop-down box shows the active build configuration, but you
can choose a different one and provide any actions. You specify one or more actions with the Select Project
Operation drop-down box. Supported actions are Before Build, Build, After Build, Before Clean, Clean, After
Clean, and Custom Command. Figure 2-14 shows an example based on the After Build action.

O Project Options - HelloWorld
v G 1
s Custom Commands
# Main Settings
T Configuration: Debug (Active)| | Platt Any CPU|
onfiguration: ebug ctive r atform: ny | v
> General ==

# Custom Commands Visual Studio can execute user specified commands or scripts before, after or as

3 Confi " a replacement of common project operations. It is also possible to enter custom
ONNIGUraions commands which will be available in the project or solution menu.

@ Compiler
& Assembly Signing After Build LJ Remove
4 Output ;
v i Command: L | Browse.. v
%% Conmalaming Working Directory: ES{SolulionDi(} | v
P Default :
¥ Source Code Run on external console

8 NET Naming Policies
* [3 Code Formatting
[#] Standard Header
¥ Version Control

(Select a project Operation]w

® Commit Message Style
¥ NuGet Package

# Build

[E Metadata

Figure 2-14. The Custom Commands options

You can specify the action that must be executed by supplying an application name in the Command
text box (or you can click Browse instead of manually typing the name). Commands could need to receive
parameters, for example, the solution or project name. Because VS for Mac identifies such parameters with
special constants, you can select the appropriate constant by clicking the button with the arrow icon and
selecting one of the self-explanatory values from the drop-down. The same applies to the Working Directory
check box, where you can specify the directory in which the command should be executed. In Figure 2-14
you can see the $(SolutionDir) constant that represents the solution directory and that is listed as Solution
Directory in the constants drop-down box.
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The Configurations Tab

The Configurations tab allows you to manage build configurations. By default, it shows the Debug and
Release configurations, as you can see in Figure 2-15.

[ ] Project Options - HelloWorld

¥ General . 3
Configurations
# Main Settings

! ¥ Build I ]
Configuration v Add

I» General
# Custom Commands K Copy
| @ Compiler Remove
& Assembly Signing Bansie
& Output
¥ Run

¥ ¥ Configurations
P Default
¥ Source Code
[ .NET Naming Policies
» [F Code Formatting
[#) Standard Header
¥ Version Control
@ Commit Message Style
* NuGet Package |
# Build
Metadata

corce (KD

Figure 2-15. The Configurations options

Here you can manage configurations by adding, copying, removing, and renaming configurations with
the appropriate buttons. The reason why creating a new configuration could be useful will be clearer when
discussing the next tab, Compiler. For now, you can create a new configuration by clicking Add and then
entering the configuration name in the New Configuration dialog, as shown in Figure 2-16.

[ NoN ) New Configuration

MName: ] Cusloni

s
Platform: |Any cPU h__J

Cancel OK

Figure 2-16. Creating a new configuration
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When you click OK, the new configuration will be listed in the Configuration tab.

The Compiler Tab

The Compiler tab allows you to influence the compilation process and is very interesting. Figure 2-17 shows
how it appears.

@ Project Options - HelloWorld
¥ General

# Main Settings
¥ Build

Compiler

Configuration: Debug (Active) | Platform: Any CPU
I» General - L

# Custom Commands
O configurations

@ Compiler Generate overflow checks

General Options

% Assembly Signing Enable optimizations
4 Output s :
v Run Generate xml| documentation: |HeIIOWortd,me | | Browse...
v # Configurations Debug information: Portable [
P Default -
v Source Code Define Symbols: | TRACE;DEBUG;NETCOREAPP11
EB .NET Naming Policies Platform target: Any CPU| |
» [E Code Formatting
[#] Standard Header Wainings
¥ Version Control Warning Level: |4 | _

® Commit Message Style
¥ NuGet Package

# Build

Metadata

Ignore warnings: |1701;1702;,1705 | |

Treat warnings as errors

Figure 2-17. The Compiler options

Compiler options are per configuration, and the default is the active build configuration, but you can
select a different configuration in the Configuration drop-down box. In this way, changes you make on this
tab will be applied when you build your solution using the specified configuration. In the General Options
area, the “Generate overflow checks” check box forces the compiler to check for integer calculations overflow
and to throw an OverflowException at compile time if any. Enabling this option could be useful to make
integer calculations faster and to avoid storing results without any errors. The “Enable optimizations” check
box forces the compiler to optimize the build output so the resulting application, library, or package might
be smaller, faster, and more efficient. However, because the optimization process requires rearranging the
code in many ways, the debugging experience could be more difficult and less complete. For this reason, this
check box is automatically enabled only for the Release configuration. The “Generate xml documentation”
check box makes Visual Studio for Mac generate an XML documentation file for your objects. You can
specify an output file name in the text box. Selecting this option makes sense only if you commented your
source code with XML comments, which is explained in the “Introducing XML Comments” section later in
this chapter.
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The “Debug information” drop-down box allows specifying the level of accuracy for the debug symbols
that the compiler will generate. Technically speaking, the compiler generates a program database (. pdb)
file that contains all the information and symbols that a debugger needs to instrument an application.
Table 2-11 summarizes all the available options and their descriptions.

Table 2-11. Possible Values for the Debug Information Box

Value Description

Full Generates full debugging information and PDB files for a complete debugging
experience. Not recommended with .NET Core.

Symbols only Generates PDB files that only contain symbol information.

Portable Generates a portable, cross-platform PDB file that is optimized for .NET Core
apps and .NET Standard libraries.

Embedded Embeds debugging information into the build output.

None No debugging information is generated.

The default value for the Debug configuration in .NET Core is Portable, while for the Release
configuration it’s None. It is worth mentioning that the Portable option is quite new for the C# compiler,
as it has been introduced together with .NET Core to allow for cross-platform . pdb files. When Portable is
enabled, the compiler only includes .NET symbols and excludes everything that has to do with native code.
This makes . pdb certainly smaller and simpler, but the debugger cannot perform operations such as Edit
and Continue. Portable is definitely recommended with .NET Core projects. The Define Symbols text box
allows specifying environment variables that you can use to detect whether your code is running under a
specific build configuration. If you look at Figure 2-16, you can see that the TRACE, DEBUG, and NETCOREAPP1_1
symbols are defined. For example, you could write the following check if you wanted to execute some code
only if the active configuration for the application is Debug:

#if DEBUG
// Code inside this block will run only if the active configuration is Debug
#endif

Debug symbols are treated as constant variables, and they also are available per configuration, so if you
select another configuration such as Release, you will see different variables. Having an option to customize
the debug symbols is one of the most important reasons you might want to create custom configurations.
You can certainly extend existing build configurations with new symbols, but if you want them to be
available only in some cases, a custom configuration is the proper place. “Platform target” allows you to
specify the processor architecture that the compiler should target, and the default is Any CPU. Possible other
values are x86, x64, and Itanium. In the Warnings group, you can control how the compiler should handle
some warning messages. In C#, warnings represent potential problems that the developer should not ignore
but that do not prevent the compiler from building the project. In the Warning Level box, you can specify a
value from 0 to 4 (the latter is the default), whose description is available in Table 2-12.
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Table 2-12. Warning Level Values

Value Description

0 The compiler does not report any warning messages.

1 The compiler reports severe warning messages.

2 The compiler reports warnings as in level 1, plus less severe warnings (e.g., hiding class
members).

3 The compiler reports warnings as in level 2, plus less severe warnings (e.g., expressions

that always evaluate to true or to false).

4 The compiler reports all warnings as per level 3, plus informational warnings.

Warning messages, as well as blocking errors, are represented by a unique identifier. In the “Ignore
warnings” box, you can control which warnings must be ignored, given their identifier. Actually, in C# the
full error or warning identifier is preceded by the CS literal. In VS for Mac, the default ignored warnings
are related to problems that can occur with references to assemblies with the same name and can be left
unchanged. Later in this chapter, in the section called “Browsing Help and Documentation,” I will explain
how to find documentation about error and warning codes. If you are impatient, you can jump to that
section, have a look, and then come back here. You can also prevent the compiler from building a project by
selecting the “Treat warnings as errors” check box. Unless you have specific requirements, my suggestion is
that you leave the default selections so that you can also distinguish well between warnings and errors. The
Errors pad, described shortly, will help you get more details about warnings and errors.

The Assembly Signing Tab

The next tab is Assembly Signing, and it allows you to sign an assembly with a digital signature, also referred
to as a strong name (see Figure 2-18). Supported files are .snk and . pfx files.

46



CHAPTER 2 * GETTING STARTED WITH THE IDE AND WITH PROJECTS
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* [E] Code Formatting
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¥ Version Control
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* NuGet Package
# Build
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Figure 2-18. The Assembly Signing options

The . pfx format also allows for specifying a password, so it should be preferred. To specify a digital
signature, enable the “Sign this assembly” check box and then click Browse to select your .snk or .pfx file

from disk.

The “Delay sign assembly” check box allows you to save some space in the assembly for the digital

signature, which will be provided at a later stage.

The Output Tab

The last tab in the Build node is called Output (see Figure 2-19). Here you can specify the assembly name

and the directory for the build output.
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Figure 2-19. The Output options

Of course, Visual Studio for Mac provides some default values based on the information supplied when
you created the project, but these can be changed if required.

For .NET Core projects, an additional subfolder representing the current runtime version is also
generated, and it actually contains the build output. In the Run node, you can specify what action Visual
Studio must take when starting the project with or without debugging. More specifically, in the Default node
under Configurations, you can decide what Visual Studio for Mac must do when you start a project (see
Figure 2-20).
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Figure 2-20. The Default options for starting a project

The default option is “Start project,” which is fine for most of the times. You can select “Start external
program” if you instead want to run an external program against the current project, for example, a
third-party debugger, and you can supply the arguments for the external program. You can specify the
working directory and any environment variables the external program might need. In the case of console
applications, the default option is that they run inside an instance of the Terminal’s console, but you can
deselect the “Run on external console” check box to redirect the application’s output to the Output pad.
The other options are self-explanatory. In the Project Options dialog, you can also see other nodes such
as Source Code, Version Control, and NuGet Package. Though these options are also available per project,
they can actually be set at the IDE level in the Visual Studio options, so I will discuss them in more detail in
Chapter 13 together with other interesting features. This is also because you first need to know more about
source control support, which is discussed in Chapter 12. It is now time to walk through project options for
Xamarin.

Adding, Removing, and Renaming Items

More often than not, you will need to add new or existing files or folders to a project, for example, when you
need additional code files or resources such as images and other assets.
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Adding new and existing items to a project in VS for Mac is easy. To accomplish this, you right-click a
project name (or a folder in the project) in Solution pad and then you click Add. The submenu that appears
provides a number of options, but those related to adding files and folders are the following:

e  New File, which allows for adding a new file. This can be either a code file or any of
the supported files.

e  Add Files, which allows for adding existing files on disk into the project.
e  Add Files from Folder, which allows for adding all the files in a folder into the project.

e  Add Existing Folder, which allows for adding all the files and subfolders in a folder
recursively.

e  Add New Folder, which allows for creating a new empty folder in the project.

When you select Add » New File, Visual Studio shows the New File window, which is represented in
Figure 2-21.

o0 e New File
[@] Enoty Cass Empty Class
Misc Creates an empty class.
Text Templating |.@.‘| fE_ll'lr'lpty Enumeration
Web :

XML

| o I Empty Struct

Name: S

Cancel New

Figure 2-21. The New File dialog allows you to add new items to the project
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The list of available items is divided into several categories and may vary depending on the project
type you are working with. You can browse items in each category, and you can simply click an item to see a
description on the right side of the dialog. When ready, simply type a name for the new item and click New.

As a best practice, it is recommended that you group files that are common to a specific area or task into
subfolders. This helps you keep your code and project items well organized. For example, if you build a line-
of-business application, you might want to group files such as Customer.cs, Order.cs, or Supplier.csinto a
folder called Model or DataModel.

Visual Studio for Mac also allows adding items to solutions. The most common scenario is when you
want to add a new or existing project to the current solution. To accomplish this, in the Solution pad right-
click the solution name and then select Add » Add New Project or Add » Add Existing Project. You can also
add individual files to a solution by selecting Add » Add Files. Additionally, you can group files into folders
by selecting Add Solution Folder and then adding files to the new folder. Solution folders and individual files
are useful when you want to include items such as documents, text files, and images that you want to always
be part of the solution but that you do not want to be included in the build output.

You can remove items from a project by right-clicking and selecting Remove. The command is instead
called Delete if you want to remove a project from a solution. Make sure you remove items you really no
longer need because an improper deletion might compromise the build process.

Renaming a code file can be accomplished by right-clicking the file name in the Solution pad and then
selecting Rename. The cursor will appear on the selected file, and you will be able to enter a new name. If
you come from Visual Studio on Windows, you might expect that renaming a file that contains a type will
also rename the type. This is not supported in Visual Studio for Mac, and you will need to rename types
manually, using the technique described in the “Renaming Identifiers In-line” subsection later in the
chapter.

Working with Pads

Pads are floating tool windows that are responsible for various tasks. Pads in Visual Studio for Mac can be
compared to tool windows in Visual Studio on Windows and to pads in Apple’s Xcode. Pads can be docked
and arranged in the workspace according to your preferences so that you can customize the development
environment in the best way for you.

In the previous sections, you have worked with the Solution pad, which allows you to browse and
manage projects and code files in a solution. In this section, you will learn about the other most important
and common pads in Visual Studio for Mac. Some other specific pads will be instead discussed where
appropriate. As a general rule, pads can be enabled by selecting View » Pads.

Note This section does not discuss debugging pads, which are instead presented in the next chapter.

Docking, Hiding, and Rearranging Pads

When you open a pad, it is automatically docked and positioned in a specific place in the IDE, but you can
rearrange pads as you like. You can also undock a pad and treat it as a stand-alone window. Pads can also
autohide so that you can show them only when necessary and maximize the editor area, by simply clicking
their label. To undock a pad, you click its title, drag it by keeping the mouse left button pressed, and then
release when you see that its height is not constrained into other areas of the workspace. Figure 2-22 shows
how to undock the Solution pad.
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Figure 2-22. Undocking a pad

In the undocked state, a pad works like a stand-alone window; therefore, it has the classic three buttons
to close, minimize, and maximize it. You can dock a floating pad by simply clicking the Dock button on
its toolbar. Visual Studio will automatically dock the pad in the position it was docked previously. In the
docked state, the Dock button changes to Auto-Hide, which you can click to completely hide the pad except
for its label, which you can click to open the pad. Then it will be autohidden again once you click outside
of it. In Figure 2-28, you can see a number of pads in a hidden state and with only their labels visible, such
as Classes, Toolbox, Properties, Document Outline, and Unit Tests. You can also completely close a pad
by clicking the Close button on its toolbar, but then you will need to select View » Pads to open it again.
To rearrange a pad in the workspace, you click the pad’s title and then move it to the desired position, as
demonstrated in Figure 2-23.
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Figure 2-23. Moving a pad to a different position

When moving a pad, the IDE draws rectangles that represent a place in which it’s possible to dock the
pad. When you are satisfied with the position, just release the mouse button, and the pad will be moved to

the new place. Notice that the pad will still be visible in the original place until you release the mouse button.
After this explanation on how to arrange pads in the workspace, it’s time to get to know the most important

of them.

The Classes Pad

The Classes pad provides a hierarchical view of all the types and their members defined within the projects

in a solution. For a better understanding of how it works, inside the root namespace of the Program. cs file,
add the following code:

public enum Gender

{

Female,
Male
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interface IPerson

{
string FirstName { get; set; }
string LastName { get; set; }
string FullName();
Gender Gender { get; set; }
}
class Person: IPerson
{
public static int PeopleCounter;
public string FirstName { get; set; }
public string LastName { get; set; }
public Gender Gender { get; set; }
public string FullName()
{
return $"{FirstName} {LastName}";
}
public Person()
{
PeopleCounter += 1;
}
}

Note All the code has been added to the same file only to demonstrate some of the features of the Visual
Studio IDE both in this section and in other sections later in the chapter, but in real-world projects you should
create appropriate files for better organization and separation.

The code defines an interface called IPerson, which a class called Person implements. Among others,
the code defines a Gender enum that is used as the type for the same-named property. The Ful1Name method
returns the concatenation of FirstName and LastName, while the PeopleCounter static field acts as a counter
for all the instances of the Person class. At this point, the Classes pad appears like in Figure 2-24.
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Figure 2-24. The hierarchical view of types and members in the Classes pad
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As you can see, Classes shows all the types defined inside a namespace and can be expanded to show
the members they define. Namespaces are represented by gray icons and an open bracket. Value types
are represented by a green icon and the first letter of the type (E for enumerations and S for structures).
Reference types are represented by light blue icons and the first letter of the type (C for classes, I for
interfaces, and D for delegates). Type members are represented by a violet icon for fields and properties,
by a light blue icon for methods, and by a red icon for constants, plus the first letter of the member type
(Ffor fields, P for properties, M for methods, and C for constants). Notice that, in the case of C# auto-
implemented properties, the Classes pad also shows the backing fields that the compiler generates
behind the scenes. Icons also help with understanding a type or member’s visibility: if a type or member
is public, the icon has no border; if it is private, the icon has a strong border; if it is protected, the icon
has a thin border; and if it is internal, the icon has thin borders only around its corners. Notice how, for
static members, an overlay icon representing four black squares is added to the object icon. If you double-
click a type or member in the Classes pad, the code editor will immediately move the cursor to that type
or member, and it will also highlight all the occurrences of its name in the code file. The Classes pad is
extremely useful to get a visual representation of the hierarchy of objects in your solutions and is a perfect
companion for the Solution pad.

The Errors Pad

The Errors pad shows all the messages that Visual Studio for Mac generates during the development of an
application. Messages can be of three kinds.

e  Errors: These include any problems or blocking errors that the compiler encounters
and that prevent your code from being successfully compiled and, consequently,
that prevent your application from running. Examples of errors are attempting to use
an undefined object, syntax errors, and referencing missing libraries.

e  Warnings: These include messages about potential problems that actually do not
prevent your code from being compiled successfully but that should not be ignored.
The compiler also reports warnings that help you keep your code clean, for example,
with unused declared variables.

e Messages: These are just informational messages and have no impact at all on the
build process.

Figure 2-25 shows how the Errors pad displays error messages.

€4 Errors
@ 1Error 0 Warnings @ 0Messages B3 Build Output : Q
I Line Description File Project Path Category

<] 1 d (C51002) cs s

Figure 2-25. The Errors pad showing error messages
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For each error, warning, or message, the Errors pad shows the line number in the code file (Line
column), the error description (Description column), the code file where the problem was detected (File
column), in which project (Project column), and the path (Path column). Optionally, the Errors pad might
show a category based on the .NET coding rules. Messages can be filtered excluding errors, warning, and
messages by simply clicking the corresponding button or by typing key words in the search box. If you
double-click a message, the code editor will move the cursor to the code file and line number where the
problem was detected. Additionally, you can right-click a message and select Show Error Reference to find
information about the error code on the Internet.

Actually, the Errors pad is not the only way for Visual Studio to report errors and warnings. In fact, the
code editor also plays a key role in this by underlining errors and warnings with the so-called squiggles, in
other words, wavy lines that appear under code issues and that are red for errors and green for warnings.
This topic will be discussed in the next section, but it is important to mention that the Errors pad shows
errors and warnings as you type. This is possible because of the background C# compiler that performs
live static code analysis. The Errors pad takes the messages sent by the compiler, displaying them in the
list you saw in Figure 2-25. Not limited to errors and warnings, the Errors pad can also show messages that
the compiler raises during the build process. This is extremely useful to understand where and why a build
process failed and is also useful for finding possible solutions. To accomplish this, you simply click the Build
Output button in the Errors pad and then build your project or solution. Figure 2-26 shows an example of
output messages when a build fails.

]
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@ Warning(s)

1 Error(s)
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Figure 2-26. Build Output displays messages the compiler raises during the build process

Asyou can see, the compiler reports detailed information about the build process, and it also raises
error messages that explain where and why a build failed. The Build Output tools is very useful because
some errors that are not related to your code can be detected only at compile time. If the build succeeds,
then in Build Output you will see a success message. Notice that the Build Output tool can be resized as if it
were a column, and it can completely hide the error columns.
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The Properties Pad

In Visual Studio terminology, everything has properties. A property is a characteristic of a particular item,
where the item can be a file, a class, a window, a layout in a visual app, and so on. For example, the height
and width are properties of a window. The filename is instead a property of a file.

Because you often need to set properties for your .NET objects, layouts, and files, Visual Studio for Mac
provides a convenient tool to set properties called the Properties pad. The appearance of the Properties pad
is different according to the item you need to set properties for, but it generally appears as a two-column
table, in which the left column displays the property name and the right column shows or sets the property
value. Figure 2-27 shows an example of the Properties pad for a C# code file.

ols Window Help

01 Q>

= Properties 1r
=
PO a
= az o
\ 2

Build @
8
Build action Compile g
Copy to output directory Do not copy g
Custom Tool a
Custom Tool Namespace =
o
Resource ID e
(=
Misc ® §
g
5
™
4
NuGet © g
Include in Package ﬁ'
@

3 Package Console P Application Qutput - HelloWorld

Figure 2-27. The Properties pad as it appears for a C# code file
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You will use the Properties pad often in this book, so additional explanations will be provided where
appropriate. The Properties pad is particularly useful when working with user interface elements in a web
or Xamarin projects because it allows you to set object properties with a visual tool instead of setting all the
properties manually in the code.

The Tasks Pad

Keeping the focus on your productivity, Visual Studio for Mac provides an integrated tool that allows you
to create and manage task lists that can help you in the application development life cycle. This tool is the
Tasks pad.

The Tasks pad can show a list of tasks based either on specific tokens you insert in your comments
in the code or on user tasks. For example, consider Figure 2-28 where you can see the Tasks pad showing
two items.

@& VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help
o0 ® > O Debug » [| Default @ Build successful. Q-
G < 3 Program.cs = T
(¢} =
8 v Program » No selection H
§ 6 { = H
7 //TODD wait for the user input
= 8 static void Main(string[] args) =B
g 9 { 3
E‘ 10 Console.WritelLine("Hello World!"); g
11 2
12 } —
13 } B
14 g
15 public enum Gender 3
16 =
17 Female, 2
18 Male 5
19 E
20 4
21 //FIXME Add the birth date s
22 interface IPerson 3
23 { =
24 strina FirstName { aet: set: }
 Tasks
Comments ||
Line Desecription File Path

21 FIXME Add the birth date Program.cs HelloWorld
7 TODO wait for the user input  Program.cs  HelloWorld

3 Package Console B> Application Output - HelloWorld €3 Errors

Figure 2-28. The Tasks pad showing items based on comments
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Now if you take a look at the code editor, you will see two special tokens in the comments called TODO
and FIXME. When Visual Studio encounters these tokens, it understands they represent tasks that must be
done and displays them in the Tasks pad. As an enforcement, you can see how tokens have different colors
in the code editor. Supported tokens are FIXME, TODO, HACK, and UNDONE. Double-click an item, and the code
editor will move the cursor to the comment that contains the selected token. To mark a task as completed,
you can either remove the comment or right-click the task and then select Delete. Additionally, you can
create user-level tasks. In the Tasks drop-down box, select User Tasks. You will see that the Tasks pad’s layout
will change, and you will have buttons and fields to enter your tasks, providing a description and the task’s
priority (see Figure 2-29).

+ Tasks =]
User rasksu P New Task () Delete Task [ Copy Task

Priority Description

B Package Console B Application Output - Helloworld € Errors

Figure 2-29. The Tasks pad showing user tasks

While tasks based on tokens in the source code comments are per project, user tasks are available to
you regardless of the project you are working on. You can mark a user task as completed by simply selecting
the check box at the left of the task description. You can also add custom tokens, and you can customize
colors based on the task priority. To accomplish this, select Visual Studio » Preferences, and in the Tasks tab
(see Figure 2-30) you can add tokens, edit existing tokens, and customize the color that will be used in the
Tasks pad to display items, based on their priority.
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Figure 2-30. Customizing tasks

The Toolbox Pad

The Toolbox pad makes it easy to add items to your code or to elements of the user interface. Instead of
manually writing code snippets or writing the code that defines a piece of user interface at design time, you
can drag items from the Toolbox pad onto the code editor or the designer surface.

The Toolbox pad will be used many times in the next chapters, but for now you can take a look at

Figure 2-31, which shows the Toolbox as it is available over a C# code file, presenting a list of available
code snippets.
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= Exception
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nsole P Application Output - HelloWorld € Errors

Figure 2-31. The Toolbox pad for a C# code file

In this case, the Toolbox pad contains a list of code snippets that you can drag onto the code editor to
insert a ready-to-use code block.
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The Package Console Pad

The Package Console pad displays the output from the NuGet Package Manager. It is useful to understand
the process of downloading, installing, and restoring NuGet packages. You already saw this pad in action in
the “Working with NuGet Packages” subsection earlier, and Figure 2-11 shows an example.

Working with the Code Editor

The code editor in Visual Studio for Mac is the place where you will spend most of the time in your developer
life, and therefore it deserves a thorough explanation. In this section, you will learn how to get the most out
of the features that empower the code editor in order to boost your productivity, and you will see how most
of the tools work directly in the active editor window so that you will never lose the focus on your code.

As a general rule, Visual Studio will open a new editor window every time you double-click a code file in
the Solution pad. Each code file lives in a separate editor window that is represented by a tab. Visual Studio
can handle infinite editor windows (and tabs). By default, the code editor shows the full view of a code file,
but you can split a single editor window into two columns with View » Editor Columns » Two Columns.
This is useful when you need to work on different places in the same code file concurrently. Use View »
Editor Columns » One Column to restore the original view.

Using Syntax Colorization

As you would expect, Visual Studio for Mac’s code editor provides syntax colorization for all of the supported
code file types, such as C#, F#, XML, XAML, HTML, JavaScript, JSON, and Visual Basic. In all the other cases,
the code editor will treat files as plain-text documents.

Using the Edit Menu

The Edit menu offers common commands for editing source text, such as Copy, Paste, Cut, Undo, Redo, and
Select All It also provides the Format submenu, which includes commands to fix spaces such as Format
Document, Indent, and Unindent.

You can also quickly convert a line, string, or identifier to uppercase and lowercase with the same-
named commands. With Join Lines, you can bring a number of selected lines of code to a single line. With
Toggle Line Comments, you can quickly comment or uncomment one or more lines.

For each command, the Edit menu also shows the proper keyboard shortcuts. The most common are
certainly Command+C (Copy), Command+V (Paste), Command+X (Cut), and Command+Z (Undo).

Zooming the Code Editor

You can zoom the content of the active editor by pressing Option and then moving the mouse wheel up
(zoom out) and down (zoom in).

Fast Coding with IntelliSense

IntelliSense has always been one of the biggest points of strength in Microsoft Visual Studio on Windows,
and now this technology is also available in VS for Mac. IntelliSense is an advanced word completion engine,
which provides suggestions based on the context, and it offers help and tips on how to use a type or member.

IntelliSense shows up when you start typing in the code editor. Figure 2-32 shows a first example in
which the developer starts writing a type name.
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® VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help
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® 1 using System; "
2 ]
& 3- namespace HelloWorld
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26 string FullName();
27 Gender Gender { get; set; }
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29
38 class Person: IPerson
31
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(3 Package Conscle P Application Output - HelloWorld €3 Errors

Figure 2-32. IntelliSense showing the list of words matching what you type

IntelliSense automatically filters the list of available words for completion as you type. When you scroll
the list and select an item, a tooltip appears and shows documentation about that item.

Note

IntelliSense is able to show documentation only if this has been provided via XML comments, which
is certainly the case with .NET libraries, but it is something you must remember if you want IntelliSense to work
the same way against types and members you code.

You can press the spacebar or Tab to insert the selected word. Notice how items in the list have the same
icons with the same colors you saw previously with the Classes pad. It is worth mentioning that IntelliSense
here is showing only what it thinks it is suitable in the current context, so it does not show reserved words or
other objects that should not be in a method body. If you insert a word and then press the dot, IntelliSense
will show objects available for the inserted item. Figure 2-33 shows an example based on a method.
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Figure 2-33. IntelliSense showing the list of members of a type

Notice how the icons and their colors match the Classes pad. Also, when you scroll the list of members,
you will see a tooltip with the member signature and the documentation. In the case of methods, if you press
the left and right cursor keys, you will be able to scroll the list of method overloads. Additionally, when you
insert methods, IntelliSense will show contextualized documentation for method parameters when you
open the left parenthesis, as shown in Figure 2-34.
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Figure 2-34. IntelliSense showing detailed documentation for method parameters
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Another demonstration of how IntelliSense provides contextualized suggestions is outside of
namespace declarations. In this case, only a few reserved words are supported, and thus IntelliSense
properly suggests only the words that the compiler accepts to be outside a namespace declaration, such as
the using, unchecked, and namespace reserved words.

Note You can customize the IntelliSense behavior in Visual Studio » Preferences » Text Editor » IntelliSense.

Inserting Code Snippets

IntelliSense also makes it easier to insert ready-to-use code snippets via the so-called templates. When you
encounter the (...) icon, you can press Tab to insert a code snippet for the given template. For instance, you
can select the (...) interface item to quickly insert an interface stub.

The code editor will then highlight all the autogenerated identifiers that you might want to rename or
that need your attention.

Introducing XML Comments

At the beginning of this section, you saw how IntelliSense displays tooltips containing summary information
about types and members and details about parameters (see Figures 2-40, 2-41, and 2-42). This kind of
documentation is available for all types and members that have been commented with the so-called XML
comments.

Most of .NET and Mono built-in types include these comments, but you can add XML comments
to your code as well so that IntelliSense will display informational tooltips for your types and members.
XML comments can be added by typing three / symbols like in the following code and then specifying the
required information:

/// <summary>

/// The main entry point of your application

/// </summary>

/// <param name="args">The command-line arguments.</param>
static void Main(string[] args)

{

}

The full documentation for XML comments is available at https://msdn.microsoft.com/en-us/
library/b2s063f7.aspx. Remember that you must select the Generate XML Comments option in the
Compiler tab of the project options, as explained in the “The Compiler Tab” subsection earlier in this
chapter (shown in Figure 2-17).

Detecting and Fixing Code Issues As You Type

The code editor in Visual Studio for Mac performs live static code analysis as you type. This means that, at
every key stroke, Visual Studio invokes the C# compiler and receives back any code issues such as errors and
warnings.

When code issues are detected, the code editor underlines the code that has issues with red squiggles
for errors and with green squiggles for warnings. Not limited to this, the code editor places an in-line
message, which contains the error description, near the code issue. Figure 2-35 shows an example based on
a class that should implement the IDisposable interface but that actually does not.
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Figure 2-35. The code editor highlights code issues

Note You can control inline messages with View » Inline messages. The default setting is Errors and
Warnings. Other available options are None and Errors.

With most of errors and warnings raised by the compiler, Visual Studio is also able to offer a proper fix.
For example, if you right-click a code issue and then select Quick Fix, the code editor will offer one or more
possible code fixes for that context, with a live preview of how the code will look after the fix. In the current
example, the code editor offers four alternatives to implement the IDisposable interface, with a live preview
for each (see Figure 2-36). As an alternative, you can click the word that is underlined with a squiggle and
wait for a little overlay line that appears over the word, which you can click to enable the quick fix actions.
Also, you can press Option+Enter to bring up the quick fix list at any time so that you do not have to move
your fingers from the keyboard.
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Figure 2-36. The code editor provides proper fixes based on the current context

The preview shows new lines of code in green, and it will highlight in red any lines of code that will be
removed by applying the fix. Listing and describing all the available code fixes for all the errors and warnings
the compiler can detect is not possible here, but just keep in mind that one or more fix is available for code
issues that occur when using the C# language and libraries from Microsoft.

Live analysis and code fixes dramatically improve your coding experience, as they provide a convenient
way to fix code issues within the active editor window, always keeping your focus on the code.

Note As atip, you can see the list of available analysis rules and of quick fix actions in the Visual Studio
preferences. To accomplish this, select Visual Studio » Preferences » Text Editor » Source Analysis » C#. The
dialog will be divided in two tabs, one containing the list of code issues and one containing the list of actions.
You can also disable and enable both via the corresponding check boxes.

Quickly Adding Using Directives

It is common for developers to write a type name that is not recognized because the namespace that defines
that type has not been imported with a proper using directive or because the type name is not fully qualified
(that is, does not include the namespace); therefore, the type name is underlined with a red squiggle, and an
error message says that the type or namespace could not be found.
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In this situation, instead of manually adding the using directive (which also implies you remember
the namespace name), you can right-click the type name, select Quick Fix, and then the pop-up menu
will offer to add the proper using directive or to fully qualify the type name by including the containing
namespace.

Behind the Scenes of Code Issues and Quick Fixes: Roslyn

The .NET Compiler Platform, also known as Project Roslyn (http://github.com/dotnet/roslyn), is the
engine behind the live static analysis, code issue detection, quick fixes, and refactorings. Roslyn provides
open source, cross-platform C# and Visual Basic compilers with rich code analysis APIs.

Put succinctly, before Roslyn, an IDE had to implement its own code analysis rules to detect issues
in the source code. This is what Microsoft had always offered with Visual Studio up to version 2013. With
Roslyn, compilers expose APIs that any tool can invoke. With these APIs, you can invoke a snapshot of the
compiler, analyze source code, retrieve any code issues, and, most important, plug in your custom analysis
rules. What you get with Visual Studio for Mac is a number of analysis rules coded at Microsoft, but these
can be extended with your analysis rules and with custom refactorings. For instance, if you produce and
sell libraries, you could also offer code analyzers that detect an improper usage of your types. Of course,
discussing Roslyn in more detail and extending the coding experience with your own rules (as well as other
topics such as code generation) is out of the scope of this book, but it is important that you know that the
analysis engine comes from the compiler and is independent from any IDE. More information can be found
athttp://github.com/dotnet/Roslyn and, if you also work with Visual Studio on Windows, in my e-book
Roslyn Succinctly, which is available for free at https://www.syncfusion.com/resources/techportal/
details/ebooks/roslyn.

Refactoring Your Code

Refactoring is the process of rewriting a piece of code in a better way, without changing its original behavior.
By leveraging the C# compiler’s APIs, the code editor in Visual Studio for Mac offers a large number of built-
in code refactorings. In this section, you will learn about the most common code refactorings.

As a general rule, you can select a piece of code, right-click, and then select either Refactor or Quick
Fix to see whether a code refactoring is available. Additionally, Visual Studio automatically detects the
availability of a code refactoring for a specific code block, so it underlines a keyword or block with an overlay
icon that you can recognize by three small dots and that you can click to discover potential refactorings.
Keep these options in mind because only the most common refactorings will be discussed here. You can
select a single identifier or type name, you can select a line of code, and you can even select a code block, as
refactorings are available at different levels.

Note As for quick fix, a live preview of the code is also available for the Refactor command.

Detecting and Removing Redundant Code

After spending a lot of time writing code, it is not uncommon to have redundant code such as unused
variables and unnecessary using directives. Redundant code does not block your builds, but it makes your
code unnecessarily more complex. Visual Studio for Mac automatically detects redundant code, which you
can recognize by a lighter color.
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For example, names of unused variables or namespaces are colored in gray instead of black, and
keywords referring to redundant code are colored in light blue. When you see redundant code, you can hover
over with the mouse, and the code editor will show a descriptive tooltip of the full message; then you can
right-click the redundant code, select Quick Fix, and choose the proper fix. Figure 2-37 shows an example
based on redundant using directives, where you can also see a live preview in which red code represents the
lines that will be removed.

® VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help
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e < > Program.cs o
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&  No selection

“

& 1- using System;
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Sort and remove usings

Options for ‘Using directive is unnecessary. >

Options for " »
1

using System;
using System.Collections;
using System.Collections.Generic;

uonnios [

namespace HelloWerld
{

//TODO wait for the user input
static void Main(string[] args)
{

- S WO~ W

e

Figure 2-37. Removing redundant code

With specific regard to using directives, you can always right-click them, select Quick Fix, and decide to
sort directives or to both sort and remove unnecessary directives.

Extracting Code Blocks

Another common refactoring technique is dividing long code blocks into smaller code blocks. For example,
you can create a method from a set of lines of code inside another method.

To accomplish this, select the code block you want to extract, right-click and select Quick Fix, and then
select Extract Method. Once the method has been created, you will be provided with an option to enter a
new method name. Another useful refactoring allows extracting an interface from a class. To accomplish
this, right-click a class name, select Quick Fix, and then select Extract Interface.

Renaming Identifiers In-line

The code editor in VS for Mac allows you to easily rename identifiers directly in-line, without modal dialogs.
For example, you can right-click a variable name and then select Refactor » Rename.

At this point, the identifier will be highlighted (see Figure 2-38). Just type the new name, and you will
see how all the occurrences of the identifier will be renamed as you type. Also, the code editor highlights the
line numbers for lines where an occurrence of the identifier is being renamed.
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Figure 2-38. In-line renaming identifiers

Moving Type Definitions to Files

In some cases, such as in the example of the Person class I provided when I discussed the Classes pad, you
might have multiple type definitions inside the same code file. This is not best practice, and Visual Studio for
Mac has a solution for that.

In fact, you can right-click a type name (such as a class name or structure name), select Quick Fix, and
then select Move To (followed by an autogenerated file name). Visual Studio for Mac will create a new C#
code file and will move the type definition into the new file that you will see in the Solution pad.

Improving Object Initialization Expressions

A common programming task is declaring an instance of an object and assigning object properties like in
the following snippet:

Person person = new Person();
person.FirstName = "Alessandro”;
person.LastName = "Del Sole";
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In Visual Studio for Mac, you can easily refactor this kind of assignment by leveraging the C# language
feature known as object initializers, which allows for assigning and initializing properties in-line, thus
rewriting the previous code as follows:

Person person = new Person()

{

FirstName = "Alessandro”,
LastName = "Del Sole"

};

Asyou can see, this way of declaring and populating an object is cleaner. The C# compiler offers a
specific refactoring for this that you can enable by right-clicking the new keyword and then selecting Quick
Fix » Object Initialization Can Be Simplified.

Refactorings for Access Modifiers

Access modifiers represent the visibility of types and members and are represented by the public, private,
internal, protected, and protected internal keywords. Most code blocks share refactorings that allow
you to quickly change the access modifier, such as To public, To private, and so on.

Refactorings for Methods and Method Parameters

The C# compiler provides some interesting code refactorings for methods and method parameters.
Table 2-13 provides a quick summary.

Table 2-13. Refactorings for Methods and Method Parameters

Name Scope Description

Change signature Method Allows you to quickly change the signature of a
method

To... Method Allows you to quickly change the access modifier
of a method

Create Overload Without Method Offers to create a method overload without

parameter parameters, if one does not already exist

Add null check for parameter Parameter Introduces a code snippet that checks whether a
parameter value is null (only with reference types)

Add contract requiring Parameter Introduces a code snippet based on the Code

parameter must not be null Contracts library that ensures the parameter value
is not null

Don’t forget the tip to right-click an object in the code editor and then to select either Quick Fix or
Refactor to see what code refactorings are available.
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Suppressing Warning Messages

Sometimes the compiler might report warnings that you are aware of or that you cannot simply avoid
because of how your code is architected. In such situations, you might want to suppress warning messages
for one or more analysis rules.

To accomplish this, you can write a #pragma warning disable directive manually, or you can simply
leverage a specific code refactoring that does the work for you. In the code editor, right-click the code that
raises a warning, then right-click, select Quick Fix » Options for {warning name}, and select Suppress {rule
code}, where {warning name} is the name of the warning as raised by the compiler at that point in the code
and {rule code} is the identifier for the analysis rule. Figure 2-39 shows an example.

Fle Edit View Search Project Buld Run Version Control Tools Window Help

> 01 Debug » (] Defautt WVisunl Stisdia for Moc Preview Qr

> 9

Brogram es o .
& Program » [T Maindstringl] args)

using System;

using System.Collections;

using System.Collections.Generic;

wpsl W | o
L3

1

2

3

4

5/ namespace HelloWorld
6

T class Program
] {

9

A/TODD wait for the user input

18 static void Main(string[] args)

it { St Add null check for par ‘

12 Console.Writeline("Hel Add contract requIring sregms ¥ —

13 T tscted

14 Person person = new Pe T:mr.:d (e Llo Weetd!™))

15 {

16 Firsthase = "Aless I::L‘:::m yReme

}; }; Lt Create overtoad without parameter

19 } 4 Change signature...

28 } Options for ‘Parameter is never usad’ » Suppress RECS0154 3 in SoLrca
21 Configure Rule in Suppression File
22 public enum Gender

23 {

2 Ferale,

25 Male

26 }

2TL Yy

Figure 2-39. Suppressing warnings

If you choose “in Source” as the option, the code editor will surround your code with the #pragma
warning disable and #pragma warning restore directives. If you instead choose the “in Suppression File”
option, the IDE will generate a file called GlobalSuppression.cs where it will store a directive that disables
the warning for all the projects.

Navigating Your Code

Visual Studio for Mac offers a number of features to browse your source code quickly and to move between
files, types, and members easily. This section explains these features, and you will learn how to additionally
increase your productivity in the editing experience.

For a better understanding of the available features, I will use the sample code provided in the section
“The Classes Pad” earlier in this chapter. A useful edit that can be done to the code is using the Move
To refactoring described in the “Moving Type Definitions to Files” subsection to move the Person class
definition to a separate Person.cs code file.
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Navigating Between Files

Instead of moving to a different file using the Solution pad, you can press Control+Tab. Visual Studio will
show a pop-up containing the list of files that can be opened with an editor window; then you can simply
keep pressing Control and press Tab to select a different file. Just release both keys when you have made
your choice.

As an alternative, you can open the Window menu and select the file you want to open in the editor,
or you can select Window » Next Document and Window » Previous Document to quickly move in the
sequence of open files.

The Scroll Bar

In Visual Studio for Mac, the editor’s scroll bar does not simply allow you to quickly move inside a source
code file. Instead, it is an advanced tool that gives you a visual, immediate representation of any relevant
information in the code.

For a better understanding, consider Figure 2-40, where you can see a C# code file that contains an
intentional error at line 12 (a missing ; ), plus a TODO comment and warnings on the args parameter of the
Main method, which is never used and therefore considered redundant.

® VisualStudio File Edit View Search Project Build Run VersionControl Tools Window Help

© [€] | 2 ) Debug » Default Visual Studio for Mac Preview Q-
o < > Program.cs o ' Person.cs v
3,9' ¢ Program » [I! Main(stringl] args)
g 5- namespace HelloWorld @
6| {
7 class Program
g 8 { =
%‘- 9 //TODO wait for the user input —
10 static void Main(string[] args) L
11 {
12 Console.WriteLine("Hello World!")
13
1411, Person person = new Person()
15 {
16 FirstName = "Alessandro",
17 LastName = "Del Sole"
18 b 2
19 } >
20 }
21
22 public enum Gender
23 {
24 Female,
25 Male
26 }
27
28 interface IPerson
29 {
30 string FirstName { get; set; }
el ctrinn | ac+Mama [ nots cot+: 1

Figure 2-40. The scroll bar showing information about the code
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Asyou can see, the scroll bar shows a number of symbols that make it easier for you to understand
where errors, warnings, comments, and the cursor are. Generally speaking, you can hover over a symbol and
see a tooltip that describes the related message; then you can click the symbol, and the code editor will move
the cursor to the line that is affected by the information. More specifically:

e  Errors are represented with a red line, whereas warnings are represented with a blue line.
e  Tasks within comments are represented with a green line.

e  The current position of the cursor is represented with a light blue glyph. If the cursor
is currently on an identifier, the scroll bar will show a red glyph for each occurrence
of the identifier in the code.

If the code contains any errors or warnings, the scroll bar will show a small colored circle at the top. This
circle will be yellow if the code contains only warnings or red if it contains at least one error. You can hover
over the circle to see a detailed message, and you can click it to quickly go to the next error or warning.

The Minimap Mode

You can right-click the scroll bar and select Show Minimap to enable a small code preview on the scrollbar,
as shown in Figure 2-41. You can scroll the map or click the code map to quickly move to a different portion
in your code file.

@ VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help

[ NoN | [ [ Debug » Default Visual Studio for Mac Preview Q-
G < > Program.cs o ' Person.cs o T
(2] =
&  «» Program » Mo selection 8
w o
@ 9 |//T0ODO wait for the user input ® &
_ 10 static void Main(string[] args)
11 { =
g 12 Console.WriteLine("Hello World!") =8
8 4

14| Person person = new Person() @

15 {

16 FirstName = "Alessandro"”, 7

17 LastName = "Del Sole" g

18 i 2

19 } b1

20 }

21

22 public enum Gender

23 {

24 Female,

25 Male

26 }

27

28 interface IPerson

29 {

30 string FirstName { get; set; }

31 string LastName { get; set; }

32 Gender Gender { get; set; }

33 string FullName();

34 }

Figure 2-41. The scroll bar showing the code map

75



CHAPTER 2 © GETTING STARTED WITH THE IDE AND WITH PROJECTS

You can disable minimap mode by right-clicking the scroll bar and then selecting Show tasks.
The code map is useful with long code files and continues to show icons and glyphs on its right side.

Block Delimiter Selection

With complex, long, and nested code snippets, it might be difficult to understand the enclosing blocks.
When you click the opening or closing tag for a given code block, VS for Mac automatically highlights both
enclosing tags, such as brackets or parentheses, as shown in Figure 2-42.

Console.WriteLine("Hello World!");

Person person = new Person()

{
FirstName = "Alessandro",
LastName = "Del Sole"

Figure 2-42. Enclosing brackets are automatically highlighted for code blocks

You can also press Option+Shift+Up arrow to select everything in the current scope; then if you press it
again, the selection will expand to the next level of scope and so on. The Option+Shift+Down arrow shortcut
reverses this.

Find All References

Find All References is a tool that allows you to quickly see how many times and where an object has been
used across the entire solution. To use this tool, right-click the name of an object and then select Find All
References. Figure 2-43 shows an example based on finding all the references for the FirstName property of
the Person class.
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@ VisualStudio File Edit View Search Project Build Run VersionControl Tools Window Help

[ NoN ] > O Debug » [ Default Visual Studio for Mac Preview Q-
e < 2 Program.cs Person.cs o = T
Q = - -
& |« Program » [ Main(string[) args) 3
: 1 { 2
12 Console.WriteLine("Hello World!"); g
@ 13 )
@ z
E-. 14 Person person = new Person() :g
15 g
16 FirstNam quickFix.. xe
17 LastName Rgefactor > P :
18 }; Go to Declaration #D 2
19 } )
20 } Navigate > @
21 i Run To Cursor #rw0
22 public enum Gender
23 38X
24 Fem Copy =c
25 Mglzle' Paste 8V
26 b Toggle Line Comment(s) %8/
27 Indent )
28 interface IPerson Unindent £
29 { i
30 string FirstName |ncert Template...
31 string LastName { -
32 Gender Gender { ¢ Version Control 2
23 cstrinn FullName()-
1 Search Results =
Project File v Text Path | |
public sring Firsthame{ get; set; } a
™ HelloWordd [0 Person.cs:11 return §*(F ) iLastName)”; A drodelsale/Projects/HelloWorkt
[ HelloWorld [0 Program.cs:18 FirstName = “Alessandro’, A oie .
@

Search completed - 3 matches,

B Package P Apr Output -
Figure 2-43. Finding all references of a type or member

The list of references appears in the Search Results pad. At the bottom of the pad you see the number
of results. The Project column shows the name of the project in which the reference was found. The File
column contains both the name and the line of the code file in which the reference was found. The Text
column is useful because it shows a preview of the code that contains the reference with syntax colorization.
The Path column shows the folder path for the code file. You can double-click a reference to move to the
related code in the editor, and Visual Studio will open a new editor window on the file if it is not the same of
the active editor window. The reference will be automatically highlighted in the code.

The Navigate Tool

The Navigate tool works similarly to Find All References, but it provides more advanced capabilities for
specific scenarios. Navigate can be enabled by right-clicking an item in your code and then selecting
Navigate. The submenu that appears offers the navigation commands summarized in Table 2-14 and whose
results are shown in the Search Results pad like for Find All References.
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Table 2-14. Available Commands in the Navigate Tools

Name Description

Find References of All Overloads Finds all references of all the overloads of a method that have been
used in the solution.

Base Symbols Shows the list of base types and interfaces that the type on which
you invoked Navigate inherits from or implements. If you invoked
Navigate on a method, it shows the list of methods that the current
one is overriding.

Derived Symbols Shows the list of types that inherit from the type on which you
invoked Navigate. If you invoked Navigate on a method, it shows the
list of methods that are overriding the current one.

Extension Methods Shows the list of extension methods for the selected type that are
defined in the current solution.

Member Overloads Shows the list of overload definitions for the type member on which
you invoked Navigate.

Implementing Members Shows the list of types or members that are implementing an abstract
type or member or an interface or its members.

For example, if you had a class Employee that inherits from Person and then you wanted to see the list of
types that derive from Person, you could right-click the Person type name and then select Navigate and then
Derived Symbols. This would produce the result shown in Figure 2-44.

@ Errors () Search Results

Project File v Text Path -1

Search completed - 1 match.

B8 Package Consocle P Application Output - HelloWorld

Figure 2-44. Finding the list of derived symbols

Browsing Objects Within a Code File

Visual Studio for Mac provides a visual way to quickly browse types and members within a code file. Each
code editor window has tabs that you can click to show the list of types defined in the active code file. When
you select a type, then you will be able to see the list of its members.

Figure 2-45 shows an example. If you click a member name, then the code editor will move the cursor to
that member’s definition.
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< > Program.cs Person.cs Employee.cs v
Person » FirstName

X

FirstName . .
2 tem.Collections.Generic;
3 FullName()

Gender
4 | HelloWorld
D

1, Peopl

6] Bk PeopleCoun- | parson
7 Person()

Figure 2-45. Browsing types and members within a code file

You fill find this feature useful, especially with long code files.

Folding Code Blocks

Code blocks can be collapsed by clicking the - symbol near the border of the code editor, and they can be
expanded by clicking +. Collapsing and expanding code blocks, in Visual Studio, is called folding. The View
menu offers a Folding submenu with the following commands:

e Disable Folding: With this command, code blocks can no longer be folded. You can
then select Enable Folding to reenable this feature.

e  Toggle Fold: With this command, you can collapse or expand an individual code
block.

e Toggle All Folds: With this command, you can collapse or expand all the code blocks
in your code file.

e  Toggle Definition: This command is useful to fold all the code blocks that are nested
inside a type or member definition.

Folding code blocks can be useful when you have long files and you need to focus only on a specific part
of the code.

Generating Types on the Fly

As a developer, you will often realize that you need to create new types while coding. Visual Studio for Mac
makes it easier to generate new types on the fly with a special kind of code refactoring. For example, suppose
you declare a new variable of type Employee but that this type does not exist in your solution yet.

Employee empli = new Employee();
As you would expect, the editor underlines the type with a red squiggle and reports an error saying that

it could not find the type. Now, if you right-click the type name and select Quick Fix, you will get a number of
options that allow you to generate the new type, as shown in Figure 2-46.

79



CHAPTER 2 © GETTING STARTED WITH THE IDE AND WITH PROJECTS

@ VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help

[ NN ] | 2 [ Debug > [ Default € Build: 1 error, 0 warnings a1 Q-
o < > Program.cs © ' Person.cs = T
% <r Program » [E3 Main(string[) args) E |
i 7 class Program o8|
8 { f
9 //TODO wait for the user input %
f;_‘ 10 static void Main(stringl[] args) =%
11 2
12 Console.WriteLine("Hello World!"); ’
13 ¥
14 Person person = new Person() S
15 3
16 FirstName = "Alessandro", 1
17 LastName = "Del Sole" ¢
18 }; |
19
20 var empll = new Emnlovee();
21 } Generate type 'Employee’ > Generate class 'Employee’ in new file
22 } Generate class 'Employee’
23 Ig ;r::el::;t]ed Generate nested class 'Employee’
24 public enum Gender o e testedntarnal Generate new type...
25 { To public
26 Female, I
27 Male
28 }
29

Figure 2-46. Generating new types on the fly

The following options are available:

e Generate class in new file: This option creates a new code file whose name is based
on the type name and adds an empty class definition with the internal access
modifier.

e  Generate class: This option generates a new class inside the active code file, with the
internal access modifier.

e  Generate nested class: This option generates a new class, nested in the current type,
with the private access modifier.

e Generate new type: This option shows a dialog that allows you to customize the
type generation, by specifying what type you want to create (class, interface,
enumeration), the access modifier, and the destination.

This quick fix is useful and allows you to keep your focus on the code while writing.

Enabling Multicursors

You can enable multiple cursors by keeping Command+Option pressed while clicking and dragging the
pointer over an area or multiple lines. To understand how this can be useful, think of a class that exposes a
number of internal properties that you want to change to public in batch.

You can press Command+Option while clicking and dragging to select all the internal keywords
only (see Figure 2-47). Then you can start typing public, and the original text will be replaced on all the
selected lines.
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@ VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help

| BN ] | 2 [ Debug > [] Default Visual Studio E...ise 2017 for Mac @ G

B € >  Pprogram.cs ) Sl T

g & Person L e FunName_ e — §

8 6 ¥ g
7 static void Main(string[] args) 8
u { g
9 Console.WriteLine("Hello World!"); _%
10 } 4
11 } g
12 ;
13- class Person o
14 { H
15 string FullName { get; set; } y
16 int Age { get; set; } <
17 DateTime DateOfBirth { get; set; } 3
18 } &
19 }
20

@ Emors o/ Tasks @ Package Console

-

Figure 2-47. Text selection with multicursors

Applying Themes

You can customize the appearance of the Visual Studio IDE with themes. When you start Visual Studio
for the first time, the IDE is styled with the default theme. To change the theme, select Visual Studio »
Preferences » Visual Style.

Select one of the available themes from the User Interface Theme drop-down box. At this writing, VS for
Mac offers the Light theme, which I have been using so far and which I will use across the book, and the Dark
theme. Figure 2-48 shows how the IDE looks with the Dark theme.
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@ VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help
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Figure 2-48. Visual Studio for Mac with the Dark theme

Changing the theme affects the IDE user interface, the code editor, and how syntax highlighting for
source code appears.

Note You could also apply a different theme only to the code editor, leaving the user interface unchanged.
To accomplish this, select Visual Studio » Preferences » Text Editor » Color Theme and either select one of
the available built-in themes or provide a custom theme based on the supported formats listed in the dialog.
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Using the Navigate To Tool

Sometimes you need to invoke a tool or command in Visual Studio but you do not remember the exact name
or you do not remember from which menu it can be invoked. In other situations, you might have a solution
with thousands of files and you do not exactly remember where a file you need is.

Visual Studio for Mac makes your life easier by providing a search box called Navigate To, located at the
upper-right corner of the IDE, where you can type the name, or just part of it, of the tool or file you need.
Visual Studio will show a contextual list of matching results, as shown in Figure 2-49. If you come from Visual
Studio on Windows, this is the counterpart of the Quick Launch tool.

t Build Run VersionControl Tools Window Help

@ Packages successfully restored. ( Q~ pe| 0]
\ g |
erson. Top Result ¢ Person
. class (file JUsers/alessandrodelsole/Projects/HelloWorkd/HelloWorkd/Person.cs)
ection
Solution [@ PeopleCounter
g Sy stem H fiedd (file [Users/alessandrodelsole/ProjectsHelloWorldHelloWorid/Person.cs)
g System.Collecti o IPerson

nterface (file [Usersfalessandrodelsole/Projects/HeloWorld/HelloWorid/Program.cs)

g System.Collect]

Files [0] Person.cs
file "Person.cs”® in project "HelloWorkd®

'space HellowWorld

X0 - Open file or solution (File)
class Program

{ & Properties

Show Properties (View (Pads))

//T0OD0 wait 1 # Open Log Directory
St at iC VO id F Opens the direclory where the diagnostic logs are stored (Help)
{ # Show Scopes
O XP (Text Editor)
Console.V # Go to Type...

{3T - Jump 1o the declaration ol type in the current workspace (Search)

Person pe # Open Android Devices

{ Android Devices (Tools)

# MarkerOperations

Firs'l Command
Lasth 4+ Open Android SDK Manager
} : Open the Android SDK Manager (Tools)
L
} Search Search in Solution...

Search Search Packages...

Figure 2-49. The Navigate To tool showing results for commands, files, and types

The list is filtered as you type and shows names of types, code files, and commands that match the
search criterion. Not limited to this, if you click Search Packages, Visual Studio will open the Add Package
dialog and search for any NuGet packages that match your search criterion. You can also click the arrow
near the magnifier icon in the search box to filter search results by file, type, and member.
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Browsing Help and Documentation

Visual Studio for Mac ships with rich documentation that covers a lot of topics and most of the needs that
you might have as a developer. The documentation is available through different tools that are explained in
this section.

The Help Pad

You can select View » Pads » Help to display the Help pad. At this writing, the Help pad shows the full
reference for the Mono framework only, and therefore it is specific to Xamarin; however, it also includes
topics that cover the C# programming language and the .NET base class library. Figure 2-50 shows the Help
pad in action.

© Help =
Base Class Library
Commands and Files

Gnome Libraries

4 v v w

Languages

» C# Compiler Error Reference
P C# Language Specification
» Mono Embedding

» Mono Libraries

» MonoMac Framework

» MonoTouch Framework

» Novell Libraries

» Xamarin.Android Framework

» Xamarin.iOS Framework

Figure 2-50. The Help pad shows the documentation for the Mono framework

Each node can be expanded so that you can see the list of topics and articles. For example, the C#
Compiler Error Reference node can be expanded to see documentation about warning and error codes and
messages that the C# compiler reports.

The Help Menu

The Help menu is the other place where you can find all the shortcuts and links to the documentation you
need about Visual Studio, Xamarin, .NET, and the C# language.

The Search text box allows you to search for help topics and commands. In the case of commands,
it automatically shows where they are located, displaying an arrow for easy identification, as shown in
Figure 2-51. Search results include commands in the IDE and topics from the Apple documentation for
macOS.
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Figure 2-51. Searching for commands and help topics with the Help menu

The API Documentation command opens an instance of the MonoDoc application, which basically
shows the same documentation available in the Help pad. Then you have four shortcuts: Microsoft
Developer Network, .NET Documentation, Xamarin Developer Center, and Xamarin University. These
shortcuts will open the web browser pointing to the corresponding documentation portals. Report a
Problem and Provide a Suggestion allow you to report a problem and send suggestions about Visual Studio
for Mac, and both match the same-named shortcuts you saw in the welcome page. In the first case, you will
report a problem via the Developer Community web site; in the second case, you will be redirected to the
User Voice web site (http://visualstudio.uservoice.com). The Open Log Directory command will open
an instance of the Finder application, pointing to the directory where Visual Studio collects log information
from Android and iOS apps while debugging. The Release Notes submenu will display the release notes in
the web browser for each of the listed products. The Diagnostics submenu contains diagnostic tools that will
not be covered in this chapter.

Summary

Visual Studio for Mac, as an integrated development environment, is the place where you spend most of the
time in your developer life. This rich chapter has provided guidance about many topics that you need to be
familiar with to be productive with the development environment.

You saw how the welcome page provides shortcuts to common tasks such as creating and opening
solutions. Then you saw how to work with projects and solutions, walking through the available project
types, especially for Xamarin and .NET Core, and you saw how to build, run, and configure projects,
including adding references to external libraries such as NuGet packages. You then discovered pads and how
they allow you to perform a number of tasks though keeping your workspace well organized. In the second
part of the chapter, you were introduced to the code editor and to the many productivity features it offers,
such as IntelliSense, live code issue detection and code fixes for errors and warnings, code refactorings, and
code navigation. In the last part of the chapter, you saw how to customize the appearance of the IDE with
themes and how to search for help topics with the Help pad and the Help menu. In the next chapter, you will
discover additional, important, and powerful features in Visual Studio for Mac, specific for debugging any
kind of application.
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CHAPTER 3

Debugging Applications

Debugging is the task of analyzing the application’s execution flow and investigating it for errors. Therefore,
debugging is one of the most important tasks in your developer life.

Debugging can be a painful experience if a development platform does not offer powerful analysis
tools. Luckily, both Xamarin and .NET Core provide powerful debuggers, and Visual Studio for Mac ships
with unified visual tools that dramatically simplify the way you debug your code and focus on productivity.
If you are familiar with Xamarin Studio or Visual Studio on Windows, you will feel at home with what Visual
Studio for Mac has to offer. If you instead come from Xcode, you will be surprised about how amazing the
debugging experience is with Visual Studio.

Meeting the Debuggers

Visual Studio for Mac leverages debuggers that ship with the two major frameworks it relies on.

For .NET Core, Visual Studio relies on the Microsoft .NET Core Debugger, which is included in the .NET
Core SDK you installed in Chapter 1. This is the same debugger used by environments such as Visual Studio
Code and Visual Studio on Windows for .NET Core apps. For Xamarin, Visual Studio leverages the Mono Soft
Debugger (http://bit.1ly/2p4MwHc), a specific debugger for Mono whose main characteristic is that it is a
cooperative debugger built into the Mono framework, which is different from most debuggers that are stand-
alone processes.

The goal of this chapter is not explaining what happens behind the scenes of the debuggers; rather, I
will explain the powerful, unified tools that the IDE provides to debug applications regardless of the backing
debugger. Obviously, Android and iOS are two different systems, and therefore the Mono Soft Debugger
will send different kinds of messages depending on the current platform. The same concept applies to the
Microsoft .NET Core Debugger, whose behavior is totally different from the Mono Soft Debugger; it will show
its own messages, and it has its own characteristics.

Preparing an Example

For a better understanding of all the available debugging tools, a good idea is to prepare an example that
contains intentional errors. So, following the lessons learned in the previous chapter, create a new .NET Core
console project and assign a name of your choice.
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When ready, edit the Main method as follows:

static void Main(string[] args)

{
// Show a welcome message. This is stored in a variable
// to demonstrate how to use some debugging tools
string welcomeMessage = "Reading a file...";
Console.WriteLine(welcomeMessage);
string content;
// Attempt to open a text file from disk
FileStream fileStream = new FileStream("file.txt",
FileMode.Open);
using (StreamReader reader = new StreamReader(fileStream))
content = reader.ReadlLine();
}
// Show the file content
Console.WritelLine(content);
}

The sample code is simple: it shows a welcome message stored in a variable and then tries to read the
content of a text file that will be shown on the screen. Notice that I've intentionally stored a message inside
a variable rather than passing it directly as an argument to Console.Writeline, and I missed a try..catch
block to handle input/output (I/0) exceptions; this is required to demonstrate how to leverage some of the
debugging tools in the IDE.

Note When you start debugging an application, Visual Studio shows a number of debugging pads, all
discussed in detail in this chapter. However, these are displayed a few seconds after the application starts. If
you select View » Debug, all the debugging pads will be displayed before you start the application and will
be populated with debugger information from the app startup. You can then revert to the previous layout by
selecting View » Code.

Debugging an Application

Asyou learned in Chapter 2, you debug an application by first selecting the Debug configuration and then
selecting Run » Start Debugging. Depending on the current development platform, Visual Studio will attach
either the Microsoft .NET Core Debugger or the Mono Soft Debugger for Xamarin.

During the whole application life cycle, Visual Studio shows any messages that the debugger sends in
the Application Output pad. Figure 3-1 shows an example based on the sample code provided previously,
where you can also see how the debugger captured an exception.
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| 3 fon Output -

Figure 3-1. The Application Output pad

The Application Output pad is of crucial importance when debugging because it shows the flow
of information that the debugger sends. This is particularly important in the case of runtime problems
and exceptions raised by your application or errors that the system might encounter when hosting your
application. Like the other pads, the Application Output pad can autohide, and it can be docked to a
different position in the IDE for your convenience. You will use the Application Output pad many times in
this chapter, so take the time to familiarize yourself with it.

Using Breakpoints and Data Visualizers

Breakpoints are probably the debugging tool you will use most frequently. They basically allow you to
control the execution flow of your applications. A breakpoint causes an application to break its execution at
the point where the breakpoint was placed.

Note Whether the application execution breaks because of a breakpoint or because of a runtime error, it
enters into break mode.

When a breakpoint is hit and the application execution stops, you can take any necessary actions, such
as investigating variable values at that point of the execution or executing the code line by line. The easiest
way to add a breakpoint is to click the leftmost column in the code editor corresponding to the line of code
that you want to be the point in which the application execution breaks. A breakpoint is easily recognizable
because it highlights in red the line of code, as shown in Figure 3-2.
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L Program.cs

g-? Program » [T} Main(string(] args)

@ 1- using System;

- 2 ~using System.IOD;

‘Q" 3

g_ 4 ?amespace DebugExamplel
5
6 class Program
7 {
8 static void Main(string[] args)
(+]
10 // Show a welcome message. This is stored in a variable
11 // to demonstrate how to use some debugging tools
1 string welcomeMessage = "Reading a file...";

@ 13 Console.WritelLine(welcomeMessage);

14

Figure 3-2. Adding a breakpoint

You can add multiple breakpoints in different code files to control the execution flow. Now start
debugging the application to see how breakpoints work. When the application is running and the debugger
encounters a breakpoint, it breaks the execution and highlights in yellow the line of code that is being
debugged, before the line is executed. Figure 3-3 shows an example.

Visual Studio File Edit View Search Project Build Run Version Control Tools Window Help

e = Debug » [] Default | » 2 % t

Program = [I} Main(stringl] args)
T UL LS ML DUY R AU L

®
[ Program.cs
@
g
3

5|4
6 class Program
7 {
8 static void Main(string[] args)
9
1@ // Show a welcome message. This is stored in a variable
11 // to demonstrate how to use some debugging tools
12 string welcomeMessage = "Reading a file...";
e 13 | Console.WriteLine(welcomeMessage);
14
15 string content;

Figure 3-3. A breakpoint being hit before the line of code is executed

Once the breakpoint has been hit and the line of code is highlighted in yellow, you can perform many
actions such as debugging in steps (discussed shortly) or investigating the content of objects and variables
with the data visualizers. Data visualizers are small pop-ups that appear when you hover your mouse over
alocal variable, field, or property. For example, if you hover your mouse over the welcomeMessage variable,
you will see a data visualizer that shows its value (see Figure 3-4).
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Figure 3-4. Investigating variables with data visualizers

In this case, the value for welcomeMessage has been supplied in code, but data visualizers are extremely
useful when variables contain the result of a calculation or the evaluation of an expression, and they allow
you to see whether the actual value is the expected result. If not, you can perform additional investigations to
see what the problem is. You can also pin a data visualizer to the code editor by clicking the icon at its right
side. Data visualizers are also available in the Locals pad, discussed shortly.

You will use data visualizers many times while debugging because they quickly help you understand
if objects are populated as expected. For now, just click the Start button in the toolbar to resume the
application execution. In the next section, you will learn more about executing code in steps.

Configuring Breakpoints with Settings and Actions

Breakpoints can be configured so that you can decide when and how they should condition the application
execution. If you right-click the red glyph of a breakpoint and then select Edit Breakpoint, you will access the
Edit Breakpoint dialog.

Here you can specify conditions and actions. Conditions determine when the debugger should break
the application execution when it encounters a breakpoint, whereas actions allow special tasks to occur
when a breakpoint is hit. They can work together for maximum control over the execution flow. Figure 3-5
shows the Edit Breakpoint dialog.
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S R P ITT I PRI

@ @] Edit Breakpoint
Breakpolnt Action

© Pause the program

Print a message and continue

When to Take Action

© When a location is reached

Advanced Conditions

When hit count is greater than or equal to 0

And the following condition is true

Cancel Apply
Figure 3-5. Editing action and conditions for a breakpoint

Let’s start with actions. In the Breakpoint Action group, the default selection is “Pause the program,”
which simply causes the debugger to break the application execution when a breakpoint is hit. This is the
behavior you saw when running the sample code after placing a breakpoint. As an alternative, the “Print
a message and continue” option will not break the application execution. Instead, it will show a message
in the Application Output pad. The interesting thing is that, in the message, you can interpolate any C#
expression within curly braces, which is useful to evaluate the value of a variable or of an object’s properties.
In the When to Take Action group, there is only one option, called “When alocation is reached.” The value
of this setting is the file name and line of code where the breakpoint is currently placed; this is a read-only
setting, so you cannot change it.

Regarding conditions, by default the application enter breaks mode every time it encounters a
breakpoint. However, sometimes you might want to place breakpoints but break the application execution
only if a certain condition is true. For example, if you are iterating a collection with a foreach loop, you
might want to break the application execution only after a certain number of iterations. To accomplish this,
you can select one of the available conditions from the Advanced Conditions combo box (see Figure 3-5).
You can see how the name of each condition starts with “When hit count is” With the “hit” word, I mean
each time a breakpoint is encountered; therefore, the application execution should stop. In other words,
conditions allow you to control a hit’s behavior. For example, the “When hit count is greater than or equal
to” condition will cause the application execution to break only after a breakpoint has been hit for a number
of times that is greater than or equal to the number that you can specify with the selector on the right.

Other condition names are self-explanatory, and the behavior of each condition is similar, except that the
condition will be “less than” or “greater to.”

You can specify additional conditions with the “And the following condition is true” and “And the
following expression changes” options. The first option allows you to specify a C# expression that must be
evaluated to true to break the application execution, whereas the second option allows you to decide that an
application should enter break mode when the value of the supplied C# expression changes.

In summary, conditions and actions are useful when you want a breakpoint to be hit only under certain
circumstances, and they allow for a better execution flow.
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Adding Function Breakpoints and Exception Catchpoints

Previously, you saw how to add a breakpoint the easy way, and then you saw how to edit a breakpoint with
conditions and actions. Visual Studio for Mac also allows you to specify conditions and actions, as well as
other options, directly when adding a new breakpoint by right-clicking the leftmost column in the code
editor and then selecting New Breakpoint.

This will open the Create a Breakpoint dialog, which looks like Figure 3-6.

| NN | Create a Breakpoint
Breakpolint Action

© Pause the program

Print a message and continue

e.g. Value of 'name' is {name]}
When to Take Action
When a function is entered
e.g. System.Object.ToString
When an exception is thrown

e.g. System.InvalidOperationException

© When a location is reached

Advanced Conditions

When hit count is greater than or equal to | 0 ‘ 'l
And the following condition is true

e.g. colorName == "Red |

Cancel Create

Figure 3-6. Adding function tracepoints and exception catchpoints

Most of the options are the same as discussed for the Edit Breakpoint dialog. Additionally, you will find
the following two actions in the When to Take Action group: “When a function is entered” and “When an
exception is thrown” (the default action is hitting the breakpoint when it's encountered). The first action
is also referred to as a function breakpoint, whereas the second option is also referred to as an exception
catchpoint. A function breakpoint will cause the debugger to break the application execution when the
specified method call is invoked, regardless of its position in the code. An exception catchpoint will cause
the debugger to break the application execution when the specified exception is thrown at runtime,
regardless of where it happens. The interesting thing is that both options are unrelated to any line of code.
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Therefore, they will act as breakpoints, but they really do not need a breakpoint in the code editor. Visual
Studio keeps track of function breakpoints and exception catchpoints and allow you to control them in the
Breakpoints pad, as you will discover in a moment. When ready, simply click Create, and a breakpoint will
be placed on the current line of code.

Investigating Runtime Errors

A runtime error is an error that occurs during application execution. Runtime errors are typically because of
programming errors that are not visible at compile time and that might involve unpredictable situations. For
example, if an application gives users the ability to write a file name but then the file is not found on disk, a
runtime error will occur.

As an additional example, if an application attempts to connect to a database that is unreachable
for network connectivity issues, a runtime error will occur. Obviously, in real-life applications, it is your
responsibility, as the developer, to predict such possibilities and implement the appropriate try..catch
blocks. However, for various reasons, unhandled runtime errors might occur, and the debugger in Visual
Studio for Mac offers the proper tools to help understand the cause of the problem. If you run the sample
code provided at the beginning (with no breakpoints), after a few seconds a runtime error will cause the
debugger to break the application execution because the code is searching for a file that does not exist. At
this point, Visual Studio highlights the line of code that caused the error and will show a tooltip that contains
the exception name and the error description, as shown in Figure 3-7.

® VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help

ece N > fault Do E |t @ Build successful.

B € 2  Program.cs = T

§ Mo selection ﬁ

g 11 rate how to use some debugging tools £
12 jeMessage = "Reading a file...";
13 iLine(welcomeMessage); c
14 A
15 | It; 3
16 -
17 1) open a text file from disk System.10.FileNotFoundException has been thrown 8
18 _leStream = new FileStream("file.txt", FileMode.Open); “Could not find file '[Users/alessandrodeisole/Projects/ i
19-|Reader reader = new StreamReader(fileStream)) Dibugtaplel/Debuoksa e /e sl £ 3

[
3@

+ reader.ReadLine();

BUIRG 1usunsog [

[(SEN
M F

i iile content
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Figure 3-7. Adding function tracepoints and exception catchpoints
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In this case, the code failed because it was searching for a file that does not exist, so a
FileNotFoundException error was thrown and was not handled by any try. .catch block; therefore, the
execution of the application was broken. So, Visual Studio shows the name of the exception that was raised
and the file name that was not found (this is included in the exception message). Actually, Visual Studio
allows you to investigate an exception further and retrieve all the details that the debugger was able to
collect. To accomplish this, click Show Details, which opens the Exception Caught dialog (see Figure 3-8).

A System.lO.FileNotFoundException

Exception Caught

"Could not find file '/Users/alessandrodelscle/Projects/DebugExamplel/DebugExamplel/file.txt'."
Mare information

¥ Stacktrace
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Figure 3-8. Investigating an exception’s details
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Exception Caught shows all the information about the exception, and because an exception is a .NET
type that inherits from System.Exception, you will see the list of exception properties depending on the
specialized exception type (in the case of a FileNotFoundException, you will see the FileName property
showing the file that was not found). At the top of the dialog, the Stacktrace item shows the hierarchy of calls
to classes and methods that effectively produced the error. By default, Stacktrace only shows information
from your code, so if you want to see the entire call hierarchy, you need to disable the “Only show my code”
option at the bottom. Also useful is the InnerException property. In our particular example, it is set to null,
but it’s not unusual for this item to show an exceptions tree that enables you to better understand what
actually caused an error. The Exception Caught dialog also allows you to investigate property values further
with data visualizers, so you can hover your mouse over a property name or its value and enable the proper
visualizer, as you learned previously in the “Using Breakpoints and Data Visualizers” section.
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Debugging Instrumentation

Visual Studio for Mac provides sophisticated tools for debugging code and analyzing the behavior of an
application. With these tools, you can control the execution flow and retrieve detailed information about
variables and object instances. They are explained in this section.

Debugging in Steps

When the application execution breaks, such as when the debugger encounters a breakpoint, you have
different options to continue the execution. For instance, you can completely resume the execution or you
can just execute one line of code per time or small sets of lines of code per time. To accomplish this, you use
anumber of commands that are available in the Run menu and in the debugging toolbar (and through the
related keyboard shortcuts). Table 3-1 describes these commands. For some of them, you can use button
shortcuts from the Debug toolbar, which you can see in Figure 3-7 between the configuration options and
the build status bar.

Table 3-1. Debugging in Steps

Command Description

Continue Debugging Resumes the application execution from the point at which it broke.
A shortcut in the Debug toolbar is available via the first button on the left.

Step Into Executes one instruction per time. This is similar to Step Over, but if
the instruction to be executed is a method, the method is executed one
instruction per time; when finished, the execution goes back to the
caller. A shortcut in the Debug toolbar is available through the third
button from the left.

Step Over Executes one instruction per time. The difference with Step Into is that
if the instruction to be executed is a method, the debugger does not
enter the method and completes its execution before going back to the
caller. This can be useful when you need to debug a portion of code that
invokes several methods you already tested and that you do not need
to delve into each time. A shortcut in the Debug toolbar is available
through the second button from the left.

Step Out Executes all lines of a method next to the current one, until the method
completes. Step Out does not work outside of methods. A shortcut in
the Debug toolbar is available through the fourth button from the left.

Run To Cursor Allows running all the code until the selected line. You call it by right-
clicking a line of code and then selecting Run To Cursor.

Set Next Statement Within a code block, allows setting the next statement to be executed
when resuming the application execution after a breakpoint or stop.

Show Next Statement Moves the cursor to the next executable statement. This can be useful if
you have long code files and breakpoints are not immediately visible.

Show Current Execution Line Moves the cursor to the current statement. This is useful when, with
long code files, the cursor is in a totally different place.
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Run To Cursor, Set Next Statement, Show Next Statement, and Show Current Execution Line are not
available in the Debug toolbar, and you can find them in the Run menu or by right-clicking the code editor.

Stepping Into Framework Code

By default, the debugger steps into your code, not into system code. However, sometimes it would be useful
to investigate further into the full code stack, which involves stepping into the code of the Mono and .NET
Core libraries.

To accomplish this, you can select Visual Studio » Preferences » Debugger and deselect the check box
called “Debug project code only; do not step into framework code.” With this option disabled, Visual Studio
will allow you to step into the source code of a system library by opening new editor windows where you will
be able to use most of the debugging tools described in this chapter.

Debugging Pads

To make it easier to analyze an application’s behavior, Visual Studio for Mac provides special pads that
you can use while debugging. Visual Studio automatically shows these pads when you start debugging
an application. If you decide to close one or more pads while debugging, you can always reenable them
individually with View » Debug Pads, and you can enable them all with View » Debug.

The Breakpoints Pad

The Breakpoints pad provides a visual representation of all the breakpoints in a solution, plus a number of
shortcuts that make it easier to add, edit, and remove breakpoints. Figure 3-9 shows an example where you
can see a breakpoint and an exception catchpoint.

(@ Breakpoints O €3 Errors
@ o ( @ (&) New Function Breakpoint € New Exception Catchpoint

Name Condition Trace Expression Hit Count Last Trace

© System.I0.FileNotFoundException

& Package Console > Application Output - DebugExamplel

Figure 3-9. The Breakpoints pad
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The Breakpoints pad shows the list of breakpoints, function breakpoints, and exception catchpoints,
each recognizable by a specific icon. For breakpoints, it shows the code file and line number and the
hit count if a condition has been specified. While debugging, the hit count will increase every time the
breakpoint is encountered. You can double-click a breakpoint, and the code editor will move the cursor to
the line where the breakpoint is. You can also disable one or more breakpoints using the check box at the left
side. The pad’s toolbar has buttons that allow you to disable, remove, edit, and add breakpoints.

The Locals Pad

The Locals pad shows the active local variables and their values while debugging. Figure 3-10 shows an
example where you can see active variables for the sample code provided previously, when stepping into
the Main method. For example, you can see how the value for the welcomeMessage variable is "Reading a
file...". This is useful especially with local variables whose value is the result of an evaluation or of an
assignment.

8o Locals oo Watch -C Threads
Name Value Type
args {string[0]} string(]
welcomeMessage # *Reading a file..." string
content (null) string
fileStream (null) System.|O.FileStream

Figure 3-10. The Locals pad

For each variable, the Locals pad shows not only the name and value but also the type. When a variable
has not been initialized yet, it shows the default value (such as null for reference types or zero for integers).
In addition, you can hover your mouse over a variable and view its content with data visualizers, and you can
even change a variable’s value by double-clicking each one.

Note Inthe Locals pad, data visualizers also show an appropriate preview based on the variable type.
For instance, if a variable represents a color, the data visualizer will show a box that depicts the color and
that shows the RGB properties, not just the C# value. Specific previews are available for types that represent
location coordinates, images, size, points, Bezier curves, collections that implement the IEnumerable interface,
and of course strings.
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The Watch Pad

The Watch pad allows for monitoring object variables, methods, or expressions so that you can monitor what
avariable is doing. When in break mode, you can enter the Watch pad and type in the name of a variable.
Visual Studio will show the value for the variable at that specific time (see Figure 3-11).

ag Locals o= Watch -C Threads
Name Value Type
content nu

Figure 3-11. The Watch pad

You need to step into the code and wait for an expression to be evaluated and assigned to the variable
you entered in the Watch pad. The pad will be updated every time the result of the evaluation changes.

The Call Stack Pad

The Call Stack pad allows you to view the hierarchy of method calls. By default, Call Stack shows calls in
your code, but you can right-click and select Show External Code to see calls to external code such as native
functions. Figure 3-12 shows an example based on the application code, with no external code.

1 Call Stack

Name

[External Code]

DebugExample1.dll!DebugExample1.Program.Main(string[] args = {string[0]}) Line 18
[External Code]

[ Package Console P Application Output - DebugExamplel €3 Errors v Tasks

Figure 3-12. The Call Stack pad
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You can right-click the view and select a number of options such as Show External Code to visualize
calls to native functions, or you can select Columns » Language to see the programming language with
which a method was written. Call Stack is particularly useful with exceptions because it helps walk you
through the hierarchy of method calls so that you can understand the actual origin for the exception.

The Threads Pad

As you now, any applications can run multiple threads, and this is true for .NET Core and Xamarin
applications too. To get a view of running threads, you can open the Threads pad. It shows a list of running
threads with summary information such as the thread ID, the name (where available), and a reference to the
code that is related to that thread (see Figure 3-13).

88 Locals oo Watch -C Threads O

Id Name Location

<No Name> 0x0 in DebugExample1.diliDebugExample1.Program.Main(string[] args = {string[0]}) Line 18 at less:

B2 Package Console Application Output - DebugExamplel
Figure 3-13. The Threads pad

This pad can be useful with multithreaded applications when you need to understand what thread a
specific code block is referring to.

Debugging in Code

Both Mono and .NET Core allow interacting with their debuggers via C# code. You can verify variables
and expressions in code and make the proper decisions if the application is not working as expected. To
accomplish this, you use the Debug class from the System.Diagnostics namespace.

Of course, you also need to select the Debug configuration. Using the class is really simple since you
invoke one of the methods it exposes, and the result of the evaluation will be shown in the Application
Output pad. For example, the following code waits for the user input from the command line and then
displays a formatted string that contains the text entered by the user and its length:

string userInput = Console.ReadlLine();
Debug.Writeline($"String {userInput} is {userInput.Length} characters long");
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The Application Output pad will display the result shown in Figure 3-14.
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Debug.dll'. Cannot find or open the PDB file.

find or open the PDB file.

Cannot find or open the PDB file.
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Figure 3-14. The output of the Debug class in the Application Output pad

Table 3-2 summarizes the most common methods from the Debug class.

Table 3-2. Methods Exposed by the Debug Class

Method Description

Assert Checks for a condition and shows a message if the condition fails, including the
stacktrace

Equals Checks two object instances for equality and returns a Boolean value

Fail Generates an error message

Write Writes the specified message without a line terminator

WriteIf Writes the specified message if a condition is true, without a line terminator

WritelLine Same as Write but adds a line terminator

WriteLineIf Same as WriteIf butadds a line terminator

With the Debug class, you can evaluate expressions without using breakpoints, which is useful when you
want to investigate the flow of your code without breaking the application execution.

Summary

Debugging is one of the most important tasks for developers, and Visual Studio for Mac simplifies the job.
This chapter explained how different debuggers exist for Mono and .NET Core and that Visual Studio for
Mac provides unified tools that allow you to interact with both debuggers seamlessly.

In this chapter, you walked through important features such as breakpoints, which allow you to control
the execution flow of your code, and commands, which allow you to execute your code step by step. With
the help of data visualizers, you can always investigate variables’ contents while debugging. Being the
powerful visual tool it is, VS for Mac also ships with a number of pads that are specific for debugging, and
in this chapter you saw what pads are available and what you can do with them to analyze your code and
your applications’ behavior. Finally, you saw how to use the System.Diagnostics.Debug class to evaluate
expressions in C#, without breaking the application execution. By completing this chapter, you now have
all the necessary knowledge about working with Visual Studio’s IDE, and now you can finally start putting
your hands on some code. Starting in the next chapter, you will learn how to create Xamarin and .NET Core
projects to build applications with Visual Studio for Mac.
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CHAPTER 4

Introducing Xamarin

Xamarin is, at the same time, the name of a company that Microsoft acquired in February 2016 and the
name of a suite of products and services Microsoft offers to developers to build native mobile applications
for Android, iOS, and the Universal Windows Platform using C# and the Microsoft developer tools.

This chapter introduces Xamarin by discussing how it fits into the mobile-first, cloud-first vision at
Microsoft and by listing the available products and services, with a brief explanation of what you can do
with each.

Note In this chapter, | will often mention Windows 10 as one of the platforms that Xamarin supports. | will
provide these mentions for the sake of completeness, but keep in mind that Visual Studio for Mac supports only
Android, i0S, macO0S, and tvOS. If you want to target the Universal Windows Platform in your Xamarin solutions,
you must use Visual Studio 2017 on Windows.

Considerations About Cross-Platform App Development

For a better understanding of how Xamarin can solve many problems and why you should really take this
technology into consideration, I will discuss the way companies build apps and the problems they face,
especially with a background on the Microsoft stack.

In the past few years, we all have seen an incredible growth in the proliferation of mobile devices, not
only smartphones and tablets but other kinds such as wearable devices, smart TVs, and Internet of Things
(IoT) devices. All of these kinds of devices are powered by the most popular operating systems, such as iOS
(Apple), Android (Google), and Windows 10 (Microsoft). With this variety of devices and operating systems,
a company that wants to increase its business by offering an app to its customers should publish a version
for each platform. This has a number of important implications.

e Different operating systems rely on proprietary APIs. These are completely different
from one another and require completely different ways to be handled.

e  The major producers (Apple, Google, and Microsoft) have their own developer tools,
frameworks, and programming languages, which are completely different from one
another. Apple provides Xcode with Swift and Objective-C, Google provides Android
Studio based on Java, and Microsoft provides Visual Studio and C#.

e Different operating systems also have their own infrastructure, rules, and settings
for the user experience and the user interface, which require knowledge of the
mechanisms that are behind the scenes of the UI on each operating system.
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Asyou can imagine, if a company wants to build and publish one or more apps to the Apple Store,
Google Play, and the Microsoft Store, it needs a number of developers with different skills and expertise. This
is certainly not uncommon for many companies, but it can be a problem if a company has always worked
only with Microsoft technologies, frameworks, platforms, and languages, such as .NET and C#, when it also
needs to be in the iOS and Android markets. In this situation, a company has typically two alternatives:
hiring i0S and Android developers or spending the time and money to make their developers skilled and
productive on the Apple and Google development platforms. In both cases, the company will have to face
potentially huge costs, and only in the first case might it save some time. So, the ideal situation would be
having an option to write apps for different operating systems reusing developers’ existing skills on C# and
.NET and sharing as much code as possible. This is where Xamarin comes in.

Understanding Xamarin and Its Objectives

Xamarin has the goal of providing developers with the tools they need to build apps for the most popular
operating systems for devices (i0S, Android, Windows 10) using C#. The biggest benefit is that developers
can reuse their existing skills with this language, and they can target multiple platforms by maximizing
code reuse.

To make this possible, Xamarin takes advantage of the Mono framework (www.mono-project.com),
an open source, cross-platform porting of .NET that runs on macOS, Windows, and Linux (and its various
distributions) and whose development was started by two founding members of Xamarin, Nat Friedman
and Miguel de Icaza. Mono supports the C# and F# programming languages and takes care of exposing
platform-specific APIs in the form of .NET namespaces and types. Over the years, Mono was ported to
mobile platforms as well, including iOS and Android. Put succinctly, Mono and C# are the foundations for
building cross-platform, native mobile apps with Xamarin. This would not be possible without C# wrapper
libraries that expose each operating system’s APIs in the form of .NET types through Mono. Table 4-1
summarizes the available libraries.

Table 4-1. Xamarin Libraries

Library Description

Xamarin.Android A wrapper for the Java framework that allows building native Android apps in
C#, including apps for wearable devices and smart TVs

Xamarin.iOS A wrapper for Apple’s frameworks that allows building native iOS apps in C# for
the iPad, the iPhone, and the Apple Watch

Xamarin.Mac A wrapper for Apple’s frameworks that allow building native applications for
macOS in C#

Xamarin.TVOS A wrapper for Apple’s frameworks that allow building native apps for tvOS

devices in C#

Xamarin.Forms A library that allows writing cross-platform apps in C# by sharing the user
interface and all the code that is not platform-specific

Asyou can easily imagine, Xamarin.Android targets only Android devices, whereas Xamarin.iOS,
Xamarin.Mac, and Xamarin.TVOS target iOS, macOS, and tvOS respectively. If you want to write code once
and generate apps that run on Android, i0S, and Windows 10, then you can leverage Xamarin.Forms, a
unified layer that allows sharing the user interface definition and code that is not platform-specific. Xamarin.
Forms is described in more detail in Chapters 7 and 8. As I mentioned at the beginning of this chapter,
Xamarin not only offers development tools but also includes a number of services. In the next subsection,

I will provide more details on what Xamarin offers.
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The Xamarin Platform

The Xamarin platform provides the development tools you use to build cross-platform apps using C#. More
specifically, the Xamarin platform includes all the libraries described in Table 4-1, plus the following tools:

e  Visual Studio for Mac, the integrated development environment that runs on macOS.

e  Extensions for Visual Studio on Windows, which make it possible to use the premiere
development environment from Microsoft to create Xamarin solutions. Both Visual
Studio 2015 and Visual Studio 2017 include Xamarin extensions out of the box, and
they can be installed separately on Visual Studio 2013.

e  Xamarin Profiler, a new tool that allows you to analyze memory usage, CPU
consumption, and where an app spends the most time. Therefore, this tool is
precious to understand where and how you can improve performances.

e Xamarin Inspector, a new tool that allows for analyzing the behavior of the user
interface of an app at runtime.

e  Xamarin Workbooks, a playground that makes it easier to learn C# and the .NET/
Mono libraries.

e  Xamarin iOS Simulator for Windows, a simulator that runs locally on Windows
machines but that is available only for Visual Studio 2015 and 2017 Enterprise.

With this powerful set of tools, you can quickly build cross-platform native apps reusing your existing C#
skills. Hints about using the Xamarin Profiler and Xamarin Inspector will be provided in the next chapters.

The Visual Studio Mobile Center

Note If you are already familiar with Xamarin and its services, you might know about Xamarin Test
Cloud and Xamarin Insights (with HockeyApp). Both are transitioning into the Visual Studio Mobile Center, and
Microsoft says the transition should be completed by the end of 2017. This is why you do not find information
about them in this chapter and why | will talk only about the new portal.

The Visual Studio Mobile Center (http://mobile.azure.com) is a new portal from Microsoft that
allows developers to fully manage the whole application life cycle for mobile apps. It is hosted on the
Microsoft Azure platform, and it offers services that cover the application life cycle with build automation,
test automation, analytics and crash reports, distribution to testers, and back-end services such as tables
and authentication, based on a DevOps approach. Figure 4-1 provides a sample view of the Visual Studio
Mobile Center where you can see all the available services on the left, based on an Android app written
with Xamarin.
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Figure 4-1. A sample view of the Visual Studio Mobile Center

To use cloud-based services from the Mobile Center in your Xamarin projects, you simply need to
install some NuGet packages that contain portable .NET libraries that make it really easy to consume
back-end services and to implement analytics. Discussing these libraries is beyond the scope of this book,
but when you associate an application to the portal, the Visual Studio Mobile Center will display the list of
NuGet packages you need and how to use them.

Actually, the Visual Studio Mobile Center is not limited to work with apps created with Xamarin; it also
supports other proprietary languages and tools. More specifically, all of its services can be used against
Android apps built with Java, iOS apps built with Objective-C and Swift, and apps built with React Native.
The following paragraphs describe all the services provided by the Visual Studio Mobile Center.

Back-End Services

Note Behind the scenes, the Visual Studio Mobile Center relies on the Azure Mobile App back-end services
that you can also control from the Azure Portal (https://portal.azure.com).

Most mobile apps need back-end services, for example, for storing data and for authenticating users.
The Visual Studio Mobile Center offers table services and identity services in the cloud. An important note is
that both require you to have a Microsoft Azure subscription (trial subscriptions are also acceptable).
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With tables, you can quickly set up a data store based on unrelated tables with rows and columns. With
the identity service, you can quickly implement authentication based on the most popular providers, such
as Microsoft, Facebook, Twitter, Google, and Azure Active Directory. You can combine the two services
to restrict access to tables only to authenticated users. The biggest benefit of using the Mobile Center
for back-end services is that it dramatically simplifies the way you create tables and how you implement
authentication, especially when compared to how you configure both in the Azure Portal.

Analytics and Crash Analysis

With one line of C# code, you can enable analytics in your Xamarin projects and make the results available
in the analytics service of the Visual Studio Mobile Center. With this service, you can review detailed
information on app crashes but also on the app usage.

For instance, you can view the number of downloads; the number of sessions and of active users;
countries where your app is downloaded the most; and information about the culture, language, and region
of devices where your app is installed. Figure 4-1 shows an example of how the Visual Studio Mobile Center
provides this information.

Build Automation

You can configure build automation for continuous integration by connecting the Visual Studio Mobile
Center to any Git repository. This way, every time you commit or push changes to your source code, the
service will automatically generate a new build. You can then certainly get detailed information about
successful and failed builds.

It is worth mentioning that the Visual Studio Mobile Center has its own Mac agent for builds, and this
potentially avoids the need of having a networked Mac when compiling Xamarin solutions for iOS. At this
writing, the build automation service can connect to GitHub, Bitbucket, and Visual Studio Team Services as
the hosts of Git repositories.

Test Automation

The test automation service allows you to execute automated tests against your apps, including U tests.
The Visual Studio Mobile Center allows you to execute tests on more than 2,000 devices and 400 different
configurations. This service is particularly useful because it allows you to fully test your app in a variety of
conditions before you ship it to customers.

Distribution to Testers

With the Visual Studio Mobile Center, you can easily send your app package to the specified testers once the
automated tests pass. Testers will receive the app directly on their devices, and you will be able to view the
analytics and telemetry information in the portal. This service is based on the HockeyApp engine, which
Microsoft acquired.

The Xamarin University

The Xamarin University (www.xamarin.com/university) is a web site that offers training materials and
courses, including live classes with instructors, where you can find everything you need to learn Xamarin
and to increase your skills, expertise, and productivity.

The Xamarin University is important because it allows you to prepare yourself to get the Xamarin
Certified Mobile Developer certification. This requires you to complete a number of classes and exams.
Additionally, the Xamarin University occasionally publishes free webinars and online technical sessions.
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Summary

In this chapter, you took a closer look at Xamarin, getting more detailed information on what it is and on
how it fits into the mobile-first, cloud-first strategy at Microsoft.

In this chapter, you saw a number of considerations about the different approaches to building mobile
applications for different OSs with proprietary technologies. Next, you saw how Xamarin solves most of the
problems by providing tools that allow developers to build mobile apps with C# in a cross-platform way. In
this discussion, you got information about the available libraries and development tools. Because Xamarin
consists not only of developer tools, this chapter also provided a high-level overview of the complete
Xamarin offerings, which includes the Xamarin platform with development tools; the Visual Studio Mobile
Center, which is based on the DevOps approach and that offers services for back-end, analytics, build
automation, test automation, and distribution to testers; and the Xamarin University, which is the place
where you can learn and attend classes that will lead you to the official Xamarin Certified Mobile Developer
certification. After this short but necessary introduction to Xamarin, in the next chapter you will start
creating Xamarin projects, and the first platform you will target is Android.
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Building Android Applications -

Android is one of the most popular operating systems for mobile devices such as smartphones, tablets,
smart watches, and smart TVs. There are many reasons for its success, but two are probably the most
relevant: it runs on an incredibly large variety of hardware configurations, which allows users to choose
between high-level and cheaper devices, and it is highly customizable.

Android natively relies on the Java runtime and libraries, but with Xamarin and its Xamarin.Android
flavor you can build apps for Android using C# and Visual Studio, thus reusing many of your existing .NET
skills. The Xamarin tools then take care of building the Android app package, leveraging the Google and Java
SDKs on your behalf. This chapter provides a high-level overview of Android app development with Visual
Studio for Mac, putting the IDE and its tool at the center.

Note As you can imagine, full guidance on the Android platform, Xamarin.Android, and the Java libraries
cannot be provided here because it would require an entire book. The focus of this chapter is explaining what
the Visual Studio for Mac IDE offers for Android development with Xamarin, based on some code examples. By
the way, here you will learn some important basic concepts about Android that will be also useful in Chapter 7.
For further studies and advanced techniques, | recommend you visit the Xamarin developer resources for
Android at https://developer.xamarin.com/guides/#android.

Preparing a Device for Development

With Visual Studio for Mac, as well as with other development environments that target the Android
system, you can debug and test your apps on both emulators and on physical devices by simply connecting
your device to an USB port on your machine. If you want to test your apps on a physical device, such as a
smartphone or a tablet, you first need to enable developer mode.

To accomplish this, you open the Settings, then tap the system information item, and finally tap the
operating system’s build number seven times. This action will enable developer mode, and it will unlock
a number of settings that are specific to development and debugging. It also will allow Visual Studio to
immediately recognize your device as a target.

Creating an Android App with Xamarin

In this chapter, you will learn what the Visual Studio IDE offers for Android development with Xamarin. You
will first create a sample solution, and then you will learn how to take advantage of all the powerful tools that
Visual Studio provides to create Android apps.
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The sample solution demonstrates how to capture a photo with the device camera and how to send it as
an e-mail attachment. This is certainly a simple example, but it allows you to focus on the IDE rather than on
complex code.

Note The sample solution combines two examples from the official GitHub repository. The first example
is about capturing a photo (https://github.com/xamarin/recipes/tree/master/android/other ux/
camera_intent/take_a_picture_and_save_using_camera_app), whereas the second example is about
sending e-mails (https://github.com/xamarin/recipes/tree/master/android/networking/email/
send_an_email).

To create a Xamarin.Android project, you select either New Project in the welcome page or File » New
Solution. In the New Project dialog (see Figure 5-1), you can select one of the available project templates
under the Android group.

[ XoN ] Mew Project

Choose a template for your new project

@ Recently used o]
F l Android Al

£ Multiplatform ndroid App
Aep ;@] Wear App

Library

p- -9
Tests WebView App "l

App Blank Android App

Libra Games
‘I’estsw Creates a blank Android app with one
E OpenGL Game screen, called an Activity.

l- Android Use this if you've worked with Android
I.z,l OpenGL ES 2.0 Game before and want 1o start with an empty U,

Library I;.:‘I OpenGL ES 3.0 Game
Tests
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Figure 5-1. Creating a Xamarin.Android project
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All the available project templates in the App, Library, and Test nodes were described in Chapter 2, so
I'will not cover them again here. In this chapter, I will use the Blank Android App project template. It differs
from the Android App template in that it does not include any UI elements. Click Next when ready. On the
next screen (“Configure your Android app”), you will need to specify some fundamental information about
your app, such as the name, the organization identifier, the target platforms, and the theme. Figure 5-2
shows an example based on my name.

| NN ] Mew Project

Configure your Android app

App Name: | SendPicture

Organization Identifier: | com.alessandrodelsole

Package Name:

Target Platforms: Maximum Compatibility
Minimum: 2.3 *Gingerbread” (AP 10) SendPicture

© Modern Development
Minimum: £.1 "Jelly Bean" [API 16)

Latest and Greatest

ere:

Holo
Holo Light
Hole Light with Dark Action Bar

Cancel Previous Next

Figure 5-2. Providing information about a new app

In the App Name text box, enter the name for your app. This can contain blank spaces. In the
Organization Identifier text box, you must supply either the organization or your identifier; this must include
the com prefix, which is also required in the package name. If you are new to Android development, it is
important that you remember that the app name and the package name are two different concepts, and the
package name identifies the app package on Google Play. Visual Studio for Mac automatically generates
the package name (see the Package Name box), so you do not need additional steps. In the Target Platforms
group box, you can specify the minimum system that your app will run on. You have the following options:

e Maximum Compatibility: This option will make your app compatible with Android
2.3 and higher; as a consequence, your app will be able to leverage only APIs
available to that Android version.

e Modern Development: This option will make your app compatible with Android 4.1
and higher and allows for leveraging a larger number of APIs.
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e  Latest and Greatest: This option allows you to leverage the most recent APIs, but your
app will run only on the latest version of Android that the SDKs installed on your
machine can target.

For the current example, select Modern Development. In the “Managing Emulators and SDKs” section,
you will learn how to install additional API targets.

Note In Android development, you will often hear about API levels. An APl level represents a specific version
of the operating system and of the API it provides and is identified by a number. For example, API Level 23 identifies
Android 6.0 Marshmallow, API Level 22 identifies Lollipop 5.1, API Level 21 identifies Lollipop 5.0, and so on. The
best way to understand what API levels refer to is using the SDK Manager described later in this chapter.

In the Theme combo box, you can select a specific graphic theme for your app. Unless you have specific
requirements, I recommend you leave the Default theme selected. When ready, click Next. On the next
screen, called “Configure your new Blank Android App” (see Figure 5-3), you will need to specify a project
name, a solution name, and a location on disk. You can leave unchanged the names and location proposed
by Visual Studio. You can optionally enable Git version control and Xamarin Test Cloud services, but these
will not be covered here (Git support will be discussed in Chapter 12).

[ XoN ] New Project
Configure your new Blank Android App
PREVIEW
I jUsersfal irodel [Projects
B sendPicture
SendPicturd [ sendPicture.sin
Proacthane: I; l B sendPicture
Solution Name: | SendPicture | () sendPicture.csproj
Location: ||'le I | rojects | Browse...

Create a project directory within the solution directory.

Version Control: Use git for version control.

~/| Create a .gitignore file to ignore inessential files.

Xamarin Test Cloud: Add an automated Ul test project. Learn More

Cancel Previous -

Figure 5-3. Configuring project information
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When ready, click Create. After a few seconds, your new solution will be ready, and Visual Studio for
Mac will show a Getting Started page that contains shortcuts to common tasks, such as opening the designer,
adding an Azure back end, and adding a unit test project. Before writing code, it is important for you to get
knowledge about the structure of Xamarin.Android solutions.

Understanding Fundamental Concepts About Xamarin.Android
Solutions

The structure of a Xamarin.Android solution reflects the structure of Android projects you can create with
native environments such as Android Studio and Eclipse, but of course the core difference is that you write
C# code. The project system is based on MSBuild solutions (.s1n files) and C# projects (.csproj files). This
is important because it means you can open a solution with both Visual Studio for Mac and Visual Studio
2017 on Windows.

If you take a look at the Solution pad, you will see a number of files and folders, summarized in Table 5-1.

Table 5-1. The Structure of a Xamarin.Android Solution

Element Type Description

Assets Folder The place where you can add files that you want to include with
your app (except for images).

Properties Folder The folder that contains the Android manifest and the
AssemblyInfo.cs file for project properties. The manifest will be
discussed later in this chapter.

Resources Folder The folder that contains images, string resources, localization
constants, and colors.

Resources\drawable  Folder The folder that contains images and icons at a default resolution.
Files with higher resolution can be added into the folders whose
name starts with mipmap.

Resources\layout Folder The folder that contains .axml files. These contain markup code
that defines pages and UI elements.

Resources\values Folder This folder contains a file called strings.xml that defines a
number of string resources. String resources will be discussed
shortly.

MainActivity.cs File A C# file that defines the class that represents the main entry point
of an Android app.

As you can see, Visual Studio generates a class that is also the main entry point for the application,
called MainActivity. The concept of an activity is important in Android, so it deserves a few lines of
explanation.
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The Concepts of Activity and Intent

In Android, an activity represents an object that allows users to interact with the device via some user
interface. An activity can be thought of as a page that contains a number of visual elements, whose
combination allows you to execute a task. In fact, generally speaking, Android does not rely on pages; rather,
it relies on activities.

Xamarin.Android exposes the Activity class from the Android.App namespace, and it is actually a
wrapper for the same-named class in Java. There is also another reason for the importance of activities:
the application life cycle depends on activities’ life cycles. Related to activities is the concept of intent. This
represents a single operation, such as sending an e-mail or making a phone call. Xamarin.Android offers the
Android.Content.Intent class that you use to define intents and that you typically assign with two pieces
of information: the action that must be executed and its data. For example, an action is sending an e-mail,
and its information includes recipients and attachments. In the sample code, you will get an example of both
activities and intents.

Understanding References and NuGet Packages

You can add and consume libraries in a Xamarin.Android solution by following the lessons learned in
Chapter 2. The References node in the Solution pad holds a list of references to system or local libraries.
If you want to consume external libraries, you can download and install NuGet packages by right-clicking
the Packages node and then selecting Add Packages in the pop-up menu.

Using Components

There is actually another way to add and consume libraries in Xamarin: components. Components are
not specific to Xamarin.Android and are available to all Xamarin flavors, including iOS, Mac, and Forms.
Components can be libraries, user controls, themes, or SDKs, and they can be downloaded from the
Xamarin’s Component Store.

In the Component Store, you can find free, trial, and paid products. Therefore, if you plan to build
reusable components for Xamarin, the Component Store provides you with a complete infrastructure for
selling your products easily. To find and download components, you can double-click the Components node
or right-click and select Edit Components to see a basic list of available components within a new tab. If you
instead right-click the Components node in the Solution pad and then select Get More Components, you
will access the complete component catalog. You will be required to enter your Xamarin account (if you do
not have one, register for free at Xamarin.com), and then you will see the list of available components (see
Figure 5-4).
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Figure 5-4. Browsing components in the Component Store

On the left side of the dialog, you can filter the list based on the component type. For each component,
one or more icons highlight what operating system it is available for. Simply click a component name to
access its details, such as full description, license information, and pricing. You will then have an option to
click Add to App to download and install the selected component. Installed components will be listed under
the Components node in the Solution pad. Additionally, the Components node will show any available
updates so that you will be able to download a new version of a library, control, or SDK with just one click.

Designing the User Interface

In Xamarin.Android, you have two options to design the user interface: editing . axml files manually or
through the Visual Studio designer. Unless you are familiar with the .axml markup, using the designer is
certainly the preferred way. The designer for Android in Visual Studio for Mac is a powerful tool: it allows
you to drag controls from the Toolbox onto the designer surface, and then you can arrange and resize
controls and set properties in the Properties pad.

Note In Android terminology, controls are referred to as widgets. From now on, | will talk about widgets
rather than controls.
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To start working with the designer, you double-click an .axml file in the solution. In the current
example, at the moment you have only one file, called Main.axml and located under Resources\layout.
When you double-click this file, Visual Studio will show the designer, the Toolbox, and the Properties and
Document Outline pads. Figure 5-5 shows an example based on the result you will obtain when completing
the example.

® VisualStudio File Edit View Search Project Build Run Version Control Tools Window Help

ece ) [ Debug » [] Android_Accelerated x86 Visual Studio Enterprise 2017 for Mac Q-
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Figure 5-5. The Android design tools in Visual Studio for Mac

Widgets are organized into containers called layouts. The combination of widgets and layouts
produces a view. In Figure 5-5, you can see two Button widgets and an ImageView widget, organized into a
LinearLayout container. The goal of this chapter is explaining the tools available in Visual Studio for Mac
to design your U, so take a look at the official documentation (http://developer.xamarin.com/guides/
android/user_interface) for full details about the available widgets and layouts. Having that said, from
the Toolbox drag two Button widgets and an ImageView widget onto the designer surface and resize the
ImageView to fill the available space. You can change widget properties with the Properties pad. Properties
might include text, size, styles, and behaviors, and they vary depending on the widget type. For example,
select the first button you dragged onto the designer. In the Properties pad, make sure the Widget tab is
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selected. Here you can assign the core properties for the widget. In the Text property, you can specify the
button text such as “Open camera.” In the Id property, you can specify the widget ID, which is particularly
useful when you need to interact with a widget in C# code. The widget ID can be compared to the control
name in other platforms such as Xamarin.Forms, Universal Windows Platform, and Windows Presentation
Foundation, but in Android it has a fixed form. You must in fact specify the @+id/ prefix, followed by a
meaningful ID for your widget, such as openCameraButton in the current example (see Figure 5-5). Every
widget has an Id property, so specify @+id/sendEmailButton for the second button and @+id/photoView for
the ImageView widget. For property values that represent colors, such as Foreground Tint and Background
Tint, the Properties pad allows selecting colors with a picker. If you scroll the Properties pad, you will find
several properties with two icons, a square with alternate filled subsquares, and a palette icon. If you click
the square, you will see a color picker like in Figure 5-6, where you can also see the two icons.
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Figure 5-6. Selecting colors with a picker
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If you instead click the palette icon, you will be able to select among possible shades for a given color
based on the Material Design colors, as shown in Figure 5-7.
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Figure 5-7. Selecting Material Design color shades

Another useful tool is the Document Outline pad. This provides a hierarchical view of layouts and
widgets and is extremely useful when the user interface becomes more complex and you want to have a
representation of the hierarchy in your views. Figure 5-8 shows the Document Outline pad as it appears at
this point of the development of the sample app.
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Figure 5-8. The Document Outline pad

You can quickly select a visual element in the designer, such as layouts and widgets, by simply clicking
an item in the hierarchy. You can also right-click an item to access shortcuts such as Copy, Cut, Delete, and
Properties. The latter will open the Properties pad for the selected item. There are other interesting tools in
the designer that you can see in Figure 5-5. First, you can see a small toolbar with four buttons for zooming
the designer in and out, to fit the window, and to highlight layout containers. In the Device combo box, you
can select one of the available devices, and the designer will adapt to the form factor of the selected device
so that you have a better idea of how your user interface will look. You can also select special form factors,
such as wearable and smart TV devices. In the Version combo box, you will be able to select the Android
version that the designer must use, and this is based on the choice you made about compatibility when
creating the project. In the Theme combo box, you have an option to select a different theme so that you can
see how the user interface appears with multiple themes. You can click the box, then click More Themes,
and finally select a theme in the Theme Selector dialog that appears. When you select a theme, the designer
will restyle the user interface based on that theme. The Portrait and Landscape buttons allow you to change
the designer orientation; then with the Resource Qualifier Options button (with three dots), you can choose
a different language for the UI and a different mode for the UI, such as normal, television, wearable, night
mode, car dock, and many others. With the Action Bar Settings button, you can control buttons that appear
in the Android’s action bar, and with the Theme Editor button, you can customize a theme with pickers and
system resources. The Material Design Grid buttons shows an overlay grid on the designer surface that will
help you respect the Material Design guidelines (http://material.io/guidelines).
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Declarative User Interface Definition

When you design the user interface, Xamarin.Android translates the designer’s content into markup code
that is stored inside .axml files. This is a tremendous benefit because the markup that Xamarin.Android
generates is the same markup that Android Studio generates, so if you have existing code written with
Android Studio, you could simply copy and paste the markup code into a Xamarin solution, and vice versa.
Additionally, if you are familiar with this markup, there are situations in which you might want to write
the markup manually. In Visual Studio for Mac, you can access the markup code of a view just by selecting
the Source tab at the bottom of the design window. This will open the .axml editor, as shown in Figure 5-9.
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Figure 5-9. The markup code for a view

The markup code is based on XML and represents the visual elements of a view in a hierarchical
way. This concept is not new to you if you have worked with the Extensible Application Markup Language
(XAML) markup language. Put succinctly, an XML element represents a layout or widget, whereas XML
attributes represent properties, and the name of each usually starts with the android: prefix. Every time you
add or edit markup code, the designer in Visual Studio will automatically reflect your changes. The .axml
code editor also has IntelliSense, which means you have the well-known, powerful code completion tool
available. It is worth mentioning that when the Source view is enabled, the Document Outline pad shows a
hierarchical representation of the XML nodes that compose the .axml file. Simply click Designer to return to
the design view. After this high-level overview of the tools you have to design an Android user interface, it is
time to make the UT alive by writing some C# code that accesses the Android APIs.
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Accessing the Android APIs in C#

In Xamarin.Android, the user interface is defined with .axml files, whereas the imperative C# code is
defined inside one or more Activity classes. For example, if you consider the current sample application,
the user interface has been defined in the Main.xaml file, and the imperative code will be written in the
MainActivity.cs file. For your convenience, the code will be split into multiple parts, and I will provide the
proper considerations.

First, add a code file called App. cs to the project. To accomplish this, right-click the project name in
the Solution pad and then select Add » New File. In the New File dialog, leave unchanged the proposed
selection about the Empty Class item template, provide the App.cs file name, and click New. The App class
will serve as a place where to store information such as the captured image, its file name, and the camera roll
folder name. The code for this class is as follows:

public static class App

{
public static File file;
public static File dir;
public static Bitmap bitmap;
}

At this point, double-click the MainActivity.cs file so that it’s open in the code editor. This class will
be the place where you will add the code that takes a photo and that shares it as an e-mail attachment. Let’s
start with the definition of the MainActivity class and with adding some using directives that import the
namespaces required to work with graphics and e-mail attachments, as shown here:

using System;

using System.Collections.Generic;
using System.Lling;

using Android;

using Android.App;

using Android.Content;

using Android.Content.PM;

using Android.Graphics;

using Android.0S;

using Android.Provider;

using Android.Widget;

using Java.IO;

using Environment = Android.0S.Environment;
using Uri = Android.Net.Uri;

namespace SendPicture
{
[Activity(Label = "Send Email With Attachment", MainLauncher = true,
Icon = "@drawable/icon")]
public class MainActivity : Activity
{
private ImageView _imageView;
Uri fileName;
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Every Android app must have a startup activity, and the app must specify which is the startup activity.
A startup activity is decorated with the Activity attribute with its MainLauncher property set as true. The
Icon property allows you to specify the icon that will be displayed in the Android’s main page (the so-called
launcher), whereas Label indicates the activity’s title. In the code there are also two fields: _imageView of
type ImageView and fileName of type Uri. These will be used shortly to store a reference to the image and
to its name. An activity’s main entry point is a method called OnCreate, which sets the specified view as the
current content view by invoking the SetContentView method. Then it executes any required initialization
code. For the current example, OnCreate must verify the availability of apps that allow for taking photos and
must create a subfolder where photos will be stored. Both checks are performed by invoking two separate
methods, as shown here:

protected override void OnCreate(Bundle bundle)
{
base.OnCreate(bundle);
// Set the main layout
SetContentView(Resource.Layout.Main);

// Check if the app has permission to write on disk

if (CheckSelfPermission(Manifest.Permission.WriteExternalStorage) ==
Permission.Granted)

{

// Check in an app for taking pictures is available
if (IsThereAnAppToTakePictures())
{
// Create a folder to store pictures
CreateDirectoryForPictures();

// Get a reference to widgets

Button captureButton = FindViewById<Button>(Resource.Id.openCameraButton);
Button sendButton = FindViewById<Button>(Resource.Id.sendEmailButton);
_imageView = FindViewById<ImageView>(Resource.Id.photoView);

// Set event handlers
captureButton.Click += CaptureButton_Click;
sendButton.Click += SendButton_Click;

It is worth noting how you get a reference to the widgets in the user interface, with the FindViewById
generic method. The type parameter is the type of widget, and the name is represented by an integer
constant that is mapped into the Resource. Id class. You can open Resource.designer.cs to discover
how both the Resource and Id classes are defined. Also, notice how Click event handlers have
been assigned to widgets using the well-known C# syntax. The following is instead the code of the
IsThereAnAppToTakePictures and CreateDirectoryForPictures methods:

private void CreateDirectoryForPictures()

{
App. dir = new File(
Environment.GetExternalStoragePublicDirectory(
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Environment.DirectoryPictures), "CameraAppDemo");
if (1App._dir.Exists())

App. dir.Mkdirs();

}

private bool IsThereAnAppToTakePictures()

{
Intent intent = new Intent(MediaStore.ActionImageCapture);
IList<ResolveInfo> availableActivities =

PackageManager.QueryIntentActivities(intent, PackageInfoFlags.MatchDefaultOnly);

return availableActivities != null && availableActivities.Count > 0;

}

The first method is simple: it gets a reference to the public folder for photos (Environment.
DirectoryPictures) via the EnvironmentGetExternalStoragePublicDirectory method, and it creates a
subfolder (Mkdirs) with the specified name. Notice that, in Xamarin.Android, file and folder management is
based on the Java.IO0.File class. The second method creates an instance of the ActionImageCapture intent.
Then the PackageManager.QueryIntentActivities method checks how many activities are available on the
system (PackageInfoFlags.MatchDefaultOnly) to execute the requested operation and returns a Boolean
value to the caller. Now that OnCreate and the methods it calls are completed, it’s time to access the camera.

Using Device Features (Camera)

To enable the built-in camera, you need to write a Click event handler for the first button. The camera

is activated with an intent of type ActionImageCapture, which this time is actually launched. Notice that
accessing some device features, such as the camera, requires the proper permissions, which will be set in the
app manifest shortly. The following is the code for the event handler:

private void CaptureButton Click(object sender, EventArgs eventArgs)

{ Intent intent = new Intent(MediaStore.ActionImageCapture);
App. file = new File(App. dir, "SampleImg.jpg");
this.fileName = Uri.FromFile(App. file);
intent.PutExtra(MediaStore.ExtraOutput, this.fileName);

} StartActivityForResult(intent, 0);
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As a general rule, an intent receives all the information it needs through the PutExtra method. In this
case, the intent receives the file name that will be used to save an image. With this approach, an intent will
receive the same information regardless of the app that the user will decide to use to take a photo. The file is
represented by an object of type Android.Net.Uri, and its path is constructed by invoking the Uri.FromFile
method. The intent is actually launched by the user interface of an app, that is, an activity. This means
that such an activity must be started, which is accomplished by invoking the StartActivityForResult
method that receives the instance of the intent that must be executed. In this particular case, the method
also receives an integer that represents the result returned by the intent if the operation succeeds. Once
the activity has completed, the runtime calls the OnActivityResult method, which is the place where you,
as a developer, can manage and evaluate the activity result. In the current example, an intent is used to
understand where the captured file should be saved (ActionMediaScannerScanFile), and then the image is
displayed in the ImageView widget. The following is the code for OnActivityResult:

protected override void OnActivityResult(int requestCode, Result resultCode, Intent data)

{
base.OnActivityResult(requestCode, resultCode, data);

if (requestCode == 0 &% resultCode == Result.Ok)
// Make it available in the gallery

Intent mediaScanIntent = new Intent(Intent.ActionMediaScannerScanFile);
Uri contentUri = Uri.FromFile(App. file);
mediaScanIntent.SetData(contentUri);

SendBroadcast(mediaScanIntent);

// Display in ImageView. We will resize the bitmap to fit the display
// Loading the full sized image will consume to much memory
// and cause the application to crash.

int height = Resources.DisplayMetrics.HeightPixels;

int width = _imageView.Height;

App.bitmap = App. file.Path.LoadAndResizeBitmap(width, height);
if (App.bitmap != null)

_imageView.SetImageBitmap(App.bitmap);
App.bitmap = null;

// Dispose of the Java side bitmap.
GC.Collect();
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The previous code needs further considerations: it detects the display height using the
DisplayMetrics.HeightPixels object, which is required to resize the picture; the code then invokes an
extension method called LoadAndResizeBitmap, which will resize the captured image for a better view,
and its definition will be provided shortly; and garbage collection is explicitly invoked (GC.Collect) to free
up some memory on the Java side. The reason is that an image object represented in C# can occupy a few
kilobytes, but the corresponding Java object can occupy several megabytes. LoadAndResizeBitmap is defined
inside a separate class called BitmapHelpers, which you should add as a new code file to the project. When
ready, write the following code (see the comments inside for a deeper understanding):

using Android.Graphics;

namespace SendPicture

{

public static class BitmapHelpers

{

public static Bitmap LoadAndResizeBitmap(this string fileName, int width, int
height)

{

// First we get the the dimensions of the file on disk
BitmapFactory.Options options = new BitmapFactory.Options

{ InJustDecodeBounds = true };
BitmapFactory.DecodeFile(fileName, options);

// Next we calculate the ratio that we need to resize the image by
// in order to fit the requested dimensions.

int outHeight = options.OutHeight;

int outWidth = options.OutWidth;

int inSampleSize = 1;

if (outHeight > height || outWidth > width)

inSampleSize = outWidth > outHeight
? outHeight / height
: outWidth / width;

}

// Now we will load the image and have BitmapFactory resize it for us.
options.InSampleSize = inSampleSize;

options.InJustDecodeBounds = false;

Bitmap resizedBitmap = BitmapFactory.DecodeFile(fileName, options);

return resizedBitmap;

The code you have seen so far is what you need to launch an intent to take a picture, elaborate its result,
and display the resulting image in the user interface.
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Network APIs: Sending E-mails

The next step is sending the captured photo as an e-mail attachment, which involves some network APIs.
Also, as you can imagine, this involves a specific intent that will be instantiated and launched in the Click
event handler of the sendEmailButton widget.

The intent you use is called ActionSend, and its general purpose is initiating communications.
Then you can specify that you need an e-mail by setting the ExtraEmail property and setting an array of
recipients. You can also specify the e-mail subject with the ExtraSubject property and attachment with the
ExtraStream property. The following code demonstrates how to send an e-mail with attachments:

private void SendButton Click(object sender, EventArgs e)

{
if (this.fileName != null)
{
var email = new Intent(Intent.ActionSend);
// Check if at least one activity exists for the specified intent
if (PackageManager.QueryIntentActivities(email,
PackageInfoFlags.MatchAll).Any())
{
email.PutExtra(Intent.ExtraEmail, new[] { "someone@email.com" });
email.PutExtra(Intent.ExtraSubject, "Sample email with attachment");
email.PutExtra(Intent.ExtraStream, fileName);
email.SetType("message/rfc822");
StartActivity(Intent.CreateChooser(email, "Email"));
}
}
}

For e-mails, it is important to set the message/rfc822 MIME type with SetType. Notice how the code starts
an activity that will ask the user to select the preferred app to start the intent, but only if any apps exist that
support sending e-mails, and this checked (again) using the PackageManager .QueryIntentActivities method.

Setting App Properties with the Android Manifest

Before testing the application, you need to know how to set properties and permissions in the manifest.
In Visual Studio for Mac, you can double-click the AndroidManifest.xml file in the Properties folder in

the Solution pad. As an alternative, you can right-click the project name and select Options » Android

Application. This will open the manifest designer, which looks similar to Figure 5-10.
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Figure 5-10. The Android manifest

The Android manifest reflects many choices you made when creating the project. The application name
and package name should be left unchanged. The application icon must instead be provided. To accomplish
this, add a file called icon.png to the drawable folder (you can certainly choose a different file name, but
remember to change the file name also in the Activity attribute applied to the MainActivity class). After
you add an icon to the project, you will be able to pick it up in the Application Icon combo box. You can
select a different theme and change the version number and name (you will do this when archiving an
app for publishing). You also have an option to select different operating system targets and to change the
install location. About the latter, I recommend you leave Default as the choice because the latest Android
versions no longer allow you to install an app for removable memory cards. More important is the “Required
permissions” box. Here you will need to specify what permissions your app requires. For the current
example, the app needs the Camera, Internet, ReadExternalStorage, and WriteExternalStorage permissions.
Once you have supplied the required information, simply save your changes. Now you are ready to build and
test the sample app.
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Building and Debugging Apps

You can run, debug, and test Xamarin.Android solutions with either emulators or physical devices, and you
can leverage all the powerful debugging tools described in Chapter 3, such as breakpoints, data visualization
tooltips, and debug pads.

If you choose to test your app on a physical device, make sure you connect your device to an USB
port of your Mac. In the Visual Studio toolbar, select the Debug configuration and then select one of the
available target devices from the combo box. Visual Studio for Mac ships with two Google emulator images
that you can use to test your apps even without a physical device. I recommend you use a physical device
to test the sample app (and all your apps) because it has full capabilities. For the purposes of this book,
figures are obviously taken from an emulator. The Android_accelerated_x86 emulator is faster than the
Android_ARMv7a image, so you should prefer the first one when not working with physical devices. When
ready, simply start debugging as you learned in Chapter 3. The IDE will start an instance of the emulator, it
will build the project, and it will deploy the app to the emulator (or physical device, of course). The first time
an app is deployed, the process will take some more time. Figure 5-11 shows the sample app running in the
emulator.

5554:VSForMac_Emulator
A U w 10:46

Send Email WithAttachment
OPEN CAMERA

SEND EMAIL

Figure 5-11. The sample app running in the emulator
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If you tap “Open camera” on the emulator, the camera will be emulated with an animation. In a
few moments I will explain how to manage emulator settings, where you will be also able to change this
behavior. Once you have taken a picture, you will be able to share it with an e-mail by tapping “Send e-mail,”
and of course you will see a preview of the image in the user interface. Figure 5-12 shows instead how you
can leverage a number of debugging tools, including breakpoints and pads.
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Figure 5-12. Debugging a Xamarin.Android project

In some cases, you will need to fine-tune the build process configuration, which is discussed in the next
subsection.

Debugging with the Xamarin Live Player

You have an additional way to test and debug an Android app on a physical device, which is the Xamarin
Live Player application. This app, available for both Android and iOS, can be installed from Google Play
(https://play.google.com/store/apps/details?id=com.xamarin.live8hl=en) and is documented at
http://xamarin.com/live.

With this app, you can pair your device to Visual Studio via a Quick Response code (QR), and then you
can select the app itself as a device target when you start debugging. Debugging an app with the Xamarin
Live Player makes particular sense when you are working with Visual Studio on Windows and you do not
have a Mac machine in your network (though a Mac is still required for advanced development including
signing iOS apps). Because with VS for Mac you are already working on a Mac and because you have fully
functional Android emulators if you do not have a physical device, using the Xamarin Live Player will not be
discussed further, but it is certainly an option that you must be informed about.
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Configuring Project Options and the Build Process

In Chapter 2, you saw how to access project options that are commonly available to all the supported project
types in VS for Mac. For Android projects, some additional, specific tabs and settings are available in the
Project Options dialog that you can access by right-clicking the project name in the Solution pad and then
selecting Options.

The Main Settings tab is identical to what you already saw in Chapter 2 and will not be covered again.
The General tab presents a drop-down box called “Target framework” where you can select the version for
the Android SDK that will be used to compile your app package (see Figure 5-13).
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Figure 5-13. The General tab for an Android project in Xamarin

By default, Visual Studio lets you use the latest version of the SDK that has been detected on your
system. You can select a different SDK version from the drop-down box. The next tab that you need to know
about is called Android Build, where you can fine-tune the compilation process and optimize the resulting
app package.

Remember that these are not Visual Studio settings; they are instead settings that are related to the
Android and Google development tools required for compilation. If you right-click the project name in
Solution pad and then select Options, the Android Build tab will look like Figure 5-14 (notice that